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安全信息
法规遵从
在实验室环境中，PSoC 4 Pioneer 套件和 CY8CKIT-042 作为硬件或软件的开发平台使用。该电路板
是一个没有屏蔽外壳的开放系统设计。因此，它会干扰接近的其他电气 / 电子器件。在国内环境中，
该产品会造成无线电干扰。在这种情况下，用户必须采取合适的预防措施。另外，请勿在任何医疗设
备或射频器件附近使用该电路板。
将其他线路添加到该产品或修改它的工厂设置情况会影响到产品的性能，并对附近的其他设备造成干
扰。如果检测到这种干扰，应该采取合适的解决措施。
CY8CKIT-042 的工厂设置情况已被验证，为了能作为 A 类产品满足 CE 的要求。
CY8CKIT-042 包含静电放电（ESD）的敏感器件。静电电荷容易堆积在
人体和任何设备上，并能够放电而没有被检测。在可进行高能放电的设
备上，会发生永久性的损害。为了避免降低性能或丢失某些功能，推荐
使用合适的 ESD 预防措施。将未使用的 CY8CKIT-042 电路板保存在保
护运输封装内。
过期时间 / 产品回收
从盒子背面显示的制造日期算起，该套件的过期时间为五年。如果想丢
弃该套件，请与您最近的回收站联系。
CY8CKIT-042 PSoC 4 Pioneer 套件指南 , 文档 # 001-90179 Rev. **
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安全信息
通用的安全指导
ESD 保护
ESD 会损坏电路板和相关组件。赛普拉斯推荐仅在 ESD 工作站上进行操作。如果 ESD 工作站不可用，
当处理各部件时，通过带上连接到电路板上底盘接地 （任何未上漆的金属表 面 ）的防静电手腕带来
防护 ESD。
处理电路板
CY8CKIT-042 电路板对 ESD 非常敏感。只能握着电路板的边缘。从盒子中取出该电路板后，将它放置
在一个接地的静态表面上。使用导电的泡沫垫 （若有）。请勿在任何表面上滑动该电路板。
4
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1.
简介
感谢您使用 PSoC® 4 Pioneer 套件。Pioneer 套件是简单易用且经济的开发套件，另外还展示了 PSoC
4 架构独特的灵活性。以灵活性为优势，本套件提供了与某些第三方的 Arduino™ 扩展板相兼容的插
座。该套件还提供了一个额外的插座，用于支持 Digilent® Pmod™ 的外设模块。另外，该电路板还
集成了 CapSense® 滑条、RGB LED、按键开关、集成 USB 编程器、编程 / 调试插座及 USB-UART/
I2C 桥接器等功能。套件支持 5 V 和 3.3 V 的电源电压。
PSoC 4 Pioneer 套件基于 PSoC 4200 系列器件为许多嵌入式应用程序提供可编程的平台。PSoC 4 是
一个可扩展和可重配置的平台架构，是一个包含 ARM® Cortex™-M0 CPU 的混合信号可编程嵌入式
系统控制器。它把可编程，可重新配置的模拟和数字模块与灵活自动布线资源相结合。
1.1
套件目录
PSoC 4 Pioneer 套件包括：
1. PSoC 4 Pioneer 电路板
2. 快速入门指南
3. USB 连接线
4. 跳线
CY8CKIT-042 PSoC 4 Pioneer 套件指南 , 文档 # 001-90179 Rev. **
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简介
图 1- 1.
套件目录
检 查 套 件 的 目 录，如 果 发 现 缺 少 了 某 一 部 分，请 与 您 附 近 的 赛 普 拉 斯 销 售 办 事 处 联 系：
www.cypress.com/go/support。
1.2
PSoC® Creator™
PSoC Creator 是最先进、简单易用的集成开发环境 （IDE）。它引进了革命性的硬件和软件协同设计
的概念，用户可方便使用预验证和预配置的 PSoC 组件 ™ 库完成设计。
使用 PSoC Creator，用户可以：
■
拖放 PSoC 组件到工作区来设计原理图
■
完成组件之间的布线，并配置 GPIO
■
使用附带的组件 API 进行开发和调试软件
PSoC Creator 还将编译链和编程软件工具整合在一起，实现了完整的软件开发工具体系。
更多有关信息，请访问 www.cypress.com/Creator 网站。
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简介
1.3
入门
通过本用户指南，用户可以了解 PSoC 4 Pioneer 套件。第 10 页上的软件安装章节 介绍了 PSoC 4
Pioneer 套件的安装。第 15 页上的套件操作章节介绍了套件的操作。它详细说明了如何使用编程器和
调试器 （板上 PSoC 5LP 或外部 MiniProg3 （CY8CKIT-002））来编程 PSoC 4。第 25 页上的硬件
章节详细说明了硬件的操作。第 41 页上的示例项目章节详细说明了代码示例的操作。第 57 页上的高
级部分章节说明了各高级内容，如创建 PSoC 5LP 的项目、 USB-UART 功能和 PSoC 5LP 的 USBI2C 功能。附录部分提供了各个原理图、引脚分配、零欧姆电阻及 NOLOAD 的用途、故障排除和材料
表 （BOM ）。
1.4
其他参考资源
有 关 数 据 手 册、技 术 参 考 手 册 及 应 用 手 册 等 形 式 的 其 他 参 考 资 源，请 访 问
www.cypress.com/PSoC4。
1.5
PSoC4
网 站：
■
初学者资源：PSoC Creator 培训：www.cypress.com/training
■
面向进阶工程师：访问网站：www.cypress.com/appnotes 查看 PSoC 3、PSoC 4 及 PSoC 5 LP 的
不断添加的应用手册列表。
■
从同事学习：访问赛普拉斯开发程序的社区论坛：www.cypress.com/forums
技术支持
寻求技术支持，请访问：www.cypress.com/support 网站，或者致电我们公司的客户支持：+1 （800）
541-4736 选择 8 号键 （美国），或： +1 （408） 943-2600 选择 8 号键 （国际）。
CY8CKIT-042 PSoC 4 Pioneer 套件指南 , 文档 # 001-90179 Rev. **
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简介
1.6
文档修订记录
表 1- 1.
修订记录
版本
**
1.7
PDF创建日期
原始版本
2013 年 4 月 23 XZNG
日
更改说明
本文档版本号为 Rev**，译自英文版 001-86371 Rev.*B
文档规范
表 1- 2.
指南的文档规范
规范
8
用途
Courier New 字体
用于显示文件位置、用户输入的文本和源代码：
C:\ ...cd\icc\
Italics 斜体字
用于显示文件名称和参考文档：
阅读 PSoC Designer 的用户指南文档中的 sourcefile.hex 文件。
[ 方括号、粗体 ]
用于显示程序中的键盘指令：
[Enter] 或 [Ctrl] [C]
File > Open
表示菜单路径：
File > Open > New Project
粗体字
使用于操作过程中的各条指令、菜单路径和图标名称：
请点击 File 图标，然后点击 Open。
Times New Roman 字体
用于显示公式：
2+2=4
灰色框中的文本
用于说明警告或产品的独特功能。
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2.1
软件安装
PSoC 4 Pioneer 套件软件
请进行下列步骤安装 PSoC 4 Pioneer 套件软件。
■
从网站：www.cypress.com/go/CY8CKIT-042 下载并安装 PSoC 4 Pioneer 套件软件。
■
选择一个文件夹，用于安装 CY8CKIT-042 （PSoC 4 Pioneer 套件）的相关文件。选择该目录并
点击 Next 按钮。
CY8CKIT-042 PSoC 4 Pioneer 套件指南 , 文档 # 001-90179 Rev. **
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软件安装
■
选择安装类型并点击 Next 按钮。
■
安装后，套件内容在以下目录中显示：
<InstallDirectory>:\CY8CKIT-042 PSoC 4 Pioneer Kit\<version>
注意：对于 Windows 7，用户安装各文件后，该文件夹将为 Read-only （只读）文件夹。先通过右击
该文件夹，依次选择 Properties > Attributes，然后禁用 Read-only 单选按钮来修改该文件夹的属
性。依次点击 Apply 和 OK 按钮关闭该窗口。
2.2
硬件安装
该套件不需要安装其他硬件。
2.3
软件安装
安装 PSoC 4 Pioneer 套件时，安装程序检查系统中是否安装了所需要的软件。如果尚未安装需要的
应用程序，安装程序将提示用户下载并安装这些应用。
需要安装的软件如下：
1. 支持 PSoC 4 器件系列的 PSoC Creator 2.2 SP1 和更高版本。从网站 www.cypress.com/go/Creator
中下载最新的软件。
2. PSoC 编程器 3.18 或更高版本：从网站 www.cypress.com/go/Programmer 中下载最新的软件。
3. 代码示例：安装该套件后，代码示例将显示在套件 Firmware 文件夹内。用户还可以从网站
www.cypress.com/go/CY8CKIT-042 中下载代码示例。
10
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软件安装
2.4
软件卸载
可以使用下列方法来卸载该软件：
2.5
■
依次选择 Start > All Programs > Cypress > Cypress Update Manager > Cypress Update
Manager ；点击 Uninstall 按钮。
■
依次选择 Start > Control Panel > Programs and Features ；点击 Uninstall/Change 按钮。
使用代码示例快速轻松地开发代码
通过使用 PSoC Creator 提供的某些示例项目可以快速轻松地开发代码。为了访问这些示例项目，在
PSoC Creator的Start Page中，点击Example and Kits部分下面的Find Example Project…项，或导
航到 Creator 工具栏菜单并依次选择 File > Open > Example Project。
图 2- 1.
Find Example Project （寻找示例项目）
Find Example Project 部分提供的各种滤波器允许用户查找最合适的项目。
PSoC Creator 还为每个器件系列提供了一些入门设计。这些设计重点介绍了专用于每个 PSoC 器件系
列的特性。它们为用户提供了一个起点而不是创建一个新的空设计。这些入门项目适用于各种组件。
要想使用某一入门设计，导航到 File > New > Project 并选择所需要的设计。
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图 2- 2.
入门设计
除了提供 PSoC Creator 的示例项目和入门设计外，赛普拉斯不断努力地提供最好的支持。要想查看
PSoC 3、 PSoC 4 及 PSoC 5 LP 的不断添加的应用笔记列表，请点击本连接。
12
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2.6
打开 PSoC Creator 中的代码示例项目
1. 启动 Start 菜单中的 PSoC Creator。
2. 点击 Examples and Kits > Kits > CY8CKIT-042 下面的 <Project.cywrk> 来打开 Start Page 中的示
例项目。
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3. 示例项目出现并在工作区浏览器中显示这些项目文件。本用户指南以下各节详细说明了如何编
译、编程和了解该套件所支持的示例项目。
14
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3.
套件操作
PSoC 4 Pioneer 套件允许用户使用 PSoC 4 器件系列来开发各种应用程序。另外，用户还可以使用
Arduino™ 扩展板和 Digilent® Pmod™ 子卡来开发各种应用程序。图 3- 1 显示的是一个包含了各个板
上组 件 参考的 PSoC 4 Pioneer 电路板的图像。
图 3- 1.
PSoC 4 Pioneer 电路板
状态LED
系统电源
跳线（J9）
Arduino
兼容
I/O插座（J3）
Arduino
兼容 I/O插座（J4）
PSoC 4 电源
跳线器
（J13）
RGB LED
Arduino 兼容ICSP
I/O插座（J12）
PSoC 5LP的10脚SWD
调试和编程插座（J7） USB连接器
（J10）
电源LED
VIN（J11）
CapSense
滑条
PSoC 4外部
编程插座（J6）
PSoC 5LP I/O 插座（J8）
PSoC 4 复位
按键
Digilent Pmod 兼容
I/O插座（J5）
PSoC 5LP
编程器和
调试器
Arduino 兼容 I/O插座
（J1）
PSoC 4
44 TQFP
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兼容 I/O插座
（J2）
按键
开关
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3.1
Pioneer 套件的 USB 接口
PSoC 4 Pioneer 套件通过一个 USB 接口连接到 PC。该套件作为复合设备枚举，而且它的三个独立设
备在 Windows 操作系统中的设备管理器窗口内显 示 。
表 3- 1.
枚举后设备管理器中的 PSoC 4 Pioneer 套件
端口
16
说明
USB 输入器件
USB-I2C 桥接器
KitProg
编程器和调试器
KitProg USB-UART
USB-UART 桥接器作为 COM# 端口显示
图 3- 2.
KitProg 驱动器的安装
图 3- 3.
KitProg 驱动器的安装
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3.2
对 PSoC 4 器件进行编程与调试
该套件允许在两种模式下对 PSoC 4 进行编程与调试：
1. 使用板上 PSoC 5LP 编程器和调试器。
2. 使用 CY8CKIT-002 MiniProg3 编程器和调试器。
3.2.1
使用板上 PSoC 5LP 编程器和调试器
该套件的默认编程接口是基于 USB 的板上编程接口。尝试对该器件进行编程前，必须安装 PSoC
Creator 和 PSoC Programmer。为 PSoC 4 Pioneer 套件安装软件时，请参考第 10 页上的软件安装章
节 的内容。
1. 为了对该器件进行编程，将 USB 线缆插入编程 USB 连接器 J10 内，如图 3- 4 所示。该套件将作为
复合设备枚举。更多的详细信息，请参考第 16 页上的 Pioneer 套件的 USB 接口 的内容。
图 3- 4.
将 USB 线缆连接到 J10
2. 板上 PSoC 5 LP 使用了 SWD 对 PSoC 4 器件进行编程。有关该实现，请参考图 3- 5。
图 3- 5.
PSoC 5LP 使用 SWD 对 PSoC 4 器件进行编程
VDD
P2[1]
Mini
USB
D+
D-
P15[6]
P15[7]
PSoC 5LP
P2[0]
P2[4]
SWDCLK
SWDIO
Reset
P3[2]
P3[3]
PSoC 4
XRES
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3. Pioneer 套件的板上编程器在 PC 和软件工具中枚举为 KitProg。加载 PSoC Creator 中的示例项目
（如 2.3 ???? 一节中所介绍的项目 ），并通过依次点击 Build > Build Project 或按组合键
[Shift]+[F6] 来编译 PSoC Creator 中的项目。
图 3- 6.
在 PSoC Creator 中创建项目
4. 编译项目后如果不发生任何错误和警报，依次选择 Debug > Program 或按组合键 [Ctrl]+[F5] 来编
程器件。
图 3- 7.
18
对 PSoC Creator 中的器件进行编程
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板上编程器仅支持 RESET 编程模式。使用板上编程器时，该电路板可以由 USB （VBUS）或一个外
部源 （如 Arduino 扩展板）供电。如果该电路板已经由其他电源供电，插入 USB 编程器也不会损坏
该板。
3.2.2
使用 CY8CKIT-002 MiniProg3 编程器和调试器
可以使用 MiniProg3 （CY8CKIT-002）来对 Pioneer 套件上的 PSoC 4 器件进行编程。要想使用
MiniProg3 进行编程，需要使用电路板上的连接器 J6，如图 3- 8 所示。除了板上编程器只能支持
RESET 编程模式，使用 Miniprog3 编程的步骤与使用板上编程器类似。不同的是 Miniprog3 可以
编程的同时给电路板供电。
为了通过 MiniProg3 供电给电路板，请依次点击 Tool > Options。在 Options 面板中，依次扩展
Program and Debug 项和 Port Configuration 项，然后选择 MiniProg3，并按图 3- 9 所显示的内容进
行设置。
注意：MiniProg3 （CY8CKIT-002）不属于 PSoC 4 Pioneer 套件的内容，并可从赛普拉斯在线商店
购买。
图 3- 8.
使用 MiniProg3 对 PSoC 4 器件进行编程 / 调试
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图 3- 9.
3.3
MiniProg3 配置
USB-UART 桥接器
板上 PSoC 5LP 能够作为一个 USB-UART 桥接器使用，使 PSoC4 和 PC 可以通过串口通信。USB
Mini B连接到PSoC 4 Pioneer套件的J10时，KitProg USBUART设备将在设备管理器中的端口（COM
和 LPT）内显示。本用户指南在第 57 页上的将 PSoC 5LP 作为 USB-UART 桥接器使用 一节中已经
对 USB-UART 的功能加以说明。
为了能在 COM 终端软件中使用 USB-UART 功能，需要选择相应的 COM 端口作为通信端口，用于传
送和接收 COM 终端软件中的数据。
PSoC 5LP 中的 UART 线被输出到插座 J8 的引脚 P12[6]（J8_9）和 P12[7] （J8_10）内。将插座 J8 上
的 TX/RX 引脚连接到在 PSoC 4 器件中分配的 RX 和 TX 引脚后，该接口可以用于传输或接收任何
PSoC 4 设计中的数据。另外，UART 可以作为其他接口使用，以方便调试。通过该桥接器还可以连接
到基于 UART 的其他外部器件。图 3- 10 显示的是用于 PSoC 5LP 和 PSoC 4 的 RX 和 TX 线之间的
连接。在该示例中， PSoC 4 UART 已布线到插座 J3，所以用户需要将 PSoC5 LP 上的 TX/RX 与
之相连。
20
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图 3- 10.
PSoC 5LP 和 PSoC 4 中 RX 和 TX 线之间的示例连接 4
表 3- 2 列出了 USB-UART 桥接器支持的规格。
表 3- 2.
USB-UART 桥接器所支持的规格
参数
波特率
数据位
奇偶校验
停止位
流量控制
支持文件传输协议
支持的值
1200、 2400、 4800、 9600、 19200、 38400、 57600 及 115200
8
无
1
无
Xmodem、 1K Xmodem、 Ymodem、 Kermit 及 Zmodem （仅超过 2400
波特的值）
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3.4
USB-I2C 桥接器
板上 PSoC 5 LP 还可以作为 USB-I2C 桥接器运行。 PSoC 4 使用 I2C 接口与 PSoC 5LP 通信，然后
PSoC 5LP 通过 USB 线缆将数据传输给 PC 上的 USB-I2C 软件工具（Bridge Control Panel（BCP））。
安装 PSoC 编程器时， BCP 也被安装。该软件可用于传送和接收 PSoC 5LP 中的 USB-I2C 数据。
USB Mini B 连接到 Pioneer 套件上的插座 J10 后，KitProg USB-I2C 器件显示在 BCP 中的 Connected
I2C/SPI/RX8 Ports （连接 I2C/SPI/RX8 端口）中。
图 3- 11.
Bridge Control Panel （桥接控制面板）
要想使用 USB_I2C 功能，选择 BCP 中的 KitProg USB-I2C。成功连接后，Connected 和 Powered
选项卡以绿色显示。
22
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图 3- 12.
桥接器控制面板中 KitProg USB-I2C 器件的连接情况
使用 PSoC 5LP 的 USB 和 I2C 组件来实现 USB-I2C。PSoC 5LP 的 SCL （P12_0）和 SDA （P12_1）
线分别连接到 PSoC 4 中 I2C 的 SCL （P3_0）和 SDA （P3_1）线。
目前 USB-I2C 桥接器支持 I2C 的以下速度：50 kHz、 100 kHz、 400 kHz 和 1 MHz。
有关使用 USB-I2C 桥接器功能来编译项目的信息，请参考第 56 页上的验证输出项 部分中介绍的内
容.
3.5
更新板上编程器 PSoC 5LP 的固件
可以通过 PSoC 编程器更新板上编程器和调试器 PSoC 5LP 的固件。
当某一新固件可用或 KitProg 固件损坏时 （请参考第 102 页上的固件中的错误 / 状态 LED 中的状态
指示 部分所介绍的内容）， PSoC 编程器将显示一个警告窗口，表示有新的固件可用。
通过 依 次选 择 Start > All Programs > Cypress > PSoC Programmer<version>，用户 可以 打 开
PSoC 编程器。
PSoC 编程器被打开时， WARNING 窗口弹出，并指出当前该编程器已过期。
图 3- 13.
更新固件的警告窗口
点击 OK 关闭该窗口。关闭警告窗口后， Action and Results 窗口将显示 “Please navigate to the
Utilities tab and click the Upgrade Firmware button”
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图 3- 14.
更新显示在 PSoC 编程器中的固件信息
依次点击 Utilities 选项卡和 Upgarde 按键来更新固件。成功更新后， Action and Results 窗口将显
示 KitProg 版本的成功信息。
图 3- 15.
24
在 PSoC 编程器中更新的固件
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4.1
硬件
电路板详细说明
PSoC 4 Pioneer 套件包括以下部分：
■ PSoC 4
■
PSoC 5LP
■
电源系统
■
编程接口 （J6、 J7 — 未组装、 J10)
■
Arduino 兼容插座 （J1、 J2、 J3、 J4 以及 J12 — 未组装）
■
Digilent Pmod 兼容插座 （J5 — 未组装 )
■
PSoC 5LP GPIO 插座 （J8）
■
CapSense® 滑条
■
Pioneer 电路板 LED
■
按键 （复位按键和用户按键）
PSoC 4 Pioneer 套件的详细说明
图 4- 1.
状态LED
系统电源
跳线（J9）
Arduino 兼容 I/O插座（J3）
Arduino PSoC 4 电源跳线器
兼容
( J13)
I/O插座（J4）
RGB LED
Arduino 兼容ICSP
I/O插座（J12）
PSoC 5LP的10脚SWD
调试和编程插座（J7） USB连接器
（J10）
电源LED
VIN( J11)
CapSense
滑条
PSoC 4外部
编程插座( J6）
PSoC 5LP I/O 插座（J8）
PSoC 4 复位
按键
Digilent Pmod 兼容 I/O插座（J5）
PSoC 5LP
编程器和
调试器
Arduino 兼容 I/O插座
（J1）
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Arduino 兼容 I/O插座
（J2）
按键开
关
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图 4- 2.
PSoC 4 Pioneer 套件的引脚映射情况
P12_6 P3_4
P5_VDD
P3_6
P0_0
GND
PSoC 5LP
I/O Header (J8)
P3_0
P3_7
P12_7
P0_1
P1_2
P3_5
VCC/P4_VDD
GND/GND
SCK/P0_6
MISO/P3_1
MOSI/P3_0
Digilent Pmod
Compatible
I/O Header (J5)
P4_0
P4_1
SS/P3_5
P1_7/AREF
GND/GND
NC
Arduino
Compatible
I/O Header (J3)
OREF/P4_VDD
RESET/RESET
3.3V/V3.3_EXT
5V/VBUS
Arduino
Compatible
I/O Header (J1)
P0_6/D13
P3_1/D12
P3_0/D11
P3_4/D10
P3_6/D9
GND/GND
P2_6/D8
GND/GND
Vin/VIN
P2_7/D7
P1_0/D6
A0/P2_0
P0_2
A1/P2_1
P0_3
A2/P2_2
VDD
A3/P2_3
P1_5
A4/P2_4
P1_4
A5/P2_5
P1_3
P0_0
GND
P0_1
P1_2
P1_0
P1_1
P3_5/D5
Arduino
Compatible
I/O Header (J2)
Arduino UNO
4.2
Arduino
Compatible
I/O Header (J4)
P0_0/D4
P3_7/D3
P0_7/D2
P0_5/D1
P0_4/D0
PSoC 4 Pioneer Kit
Digilent Pmod
操作原理
本章节介绍的是 PSoC 4 Pioneer 套件的架构说明。
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图 4- 3.
框图
PSoC 4 是赛普拉斯的新一代可编程片上系统，用于嵌入式应用。它将可编程的模拟、数字逻辑，可编
程的输入 / 输出和高性能的 ARM Cortex-M0 子系统相结合。通过使用 PSoC 4，用户可以方便的创建
外设组合，以满足应用的要求。
PSoC 4 Pioneer 套件拥有一个板上 PSoC 5LP 芯片，因此可以通过 USB 通信，使用串行线调试
（SWD）来编程和调试 PSoC 4。另外， PSoC 5LP 还可以作为 USB-I2C 桥接器和 USB-UART 桥接
器运行。
PSoC 4 Pioneer 套件具有一个 RGB LED、一个状态 LED 和一个电源 LED。RGB LED 连接到 PSoC 4，
状态 LED 连接到 PSoC 5LP。
有关状态 LED 的更多信息，请参考第 102 页上的 A.5 固件中的错误 / 状态 LED 中的状态指示 部分。
PSoC 4 Pioneer 套件也有一个 PSoC 4 复位按键。该按键连接到 PSoC 4 的 XRES、用户按键和一个用
于开发基于触摸应用程序的 5 段 CapSense® 滑条。PSoC 4 引脚被连接至该套件上的插座（J1-J4）
上，以支持 Arduino 扩展板。将 PSoC 5LP 引脚连接至插座 （J8）上，方便用户使用板上 PSoC 5LP
开发自定义应用。
PSoC 4 Pioneer 套件可以由 USB Mini B、Arduino 兼容插座或外部电源供电。LDO 电压调节器将输入
电压调节为 3.3 V。通过将跳线器插入到相配的电压选择插座 VDD 上，用户可以选择使用 VBUS （5
V）或 3.3 V。
4.3
功能描述
4.3.1
PSoC 4
该套件使用了 PSoC 4200 系列的器件。 PSoC 4200 器件组合了具有可编程逻辑的微控制器、高性能
的模数转换、支持比较器模式的两个运算放大器以及通用的固定功能外设。更多有关信息，请参考
PSoC 4 网页和 PSoC 4200 系列的数据手册。
特性
■
32 位 MCU 子系统
❐ 含有单周期硬件乘法器的 48 MHz ARM Cortex-M0 CPU
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具有读加速器的 32 kB 闪存
容量达 4 kB 的 SRAM
可编程的模拟资源
❐ 两个运算放大器包括可重新配置的高驱动外部 / 高带宽内部驱动器、支持比较器模式和 ADC 输
入缓冲功能
❐ 12 位 1 Msps 的 SAR ADC 包括差分、单端模式和具有硬件求平均功能的通道序列发生器
❐ 两个电流 DAC （IDAC），用于通用目的或电容式感应应用场合
❐ 在深度睡眠模式下可运行的两个低功耗比较器
可编程的数字资源
❐ 四个通用数字模块，每个模块包含 8 个宏单元和数据路径 （又称通用数字模块 UDB）
❐ 赛普拉斯提供了外设组件库、用户定义的状态机和 Verilog 输入
低功耗操作 （1.71 到 5.5 V）
❐ 支持 GPIO 引脚唤醒的 20 nA 停止模式
❐ 休眠和深度睡眠模式允许实现唤醒时间与功耗之间的权衡
电容式感应
❐ 赛普拉斯的电容式 Sigma-Delta （CSD）提供了一流的 SNR （>5:1）和耐水性
❐ 通过赛普拉斯提供的软件组件可以更容易地实现电容式感应设计
❐ 自动调试 （SmartSense™）
段码 LCD 驱动
❐ 所有引脚上都支持 LCD 驱动 （Com 或 Seg 驱动）
❐ 在深度睡眠模式下可运行，每个引脚拥有 4 位显示数据 RAM
串行通信
❐ 两个运行独立且可重新配置的串行通信模块 （SCB）包含可重新配置 I2C、 SPI 或 UART 功能
时序和脉冲宽度调制器
❐ 四个 16 位定时器 / 计数器脉冲宽度调制器 （TCPWM）模块
❐ 中心对齐、边缘和伪随机等模式
❐ “Kill” 终端可连接比较器触发 （针对电机驱动器）和其他可靠性高的数字逻辑应用
多达 36 个可编程的 GPIO
❐ 44 引脚 TQFP、 40 引脚 QFN 和 28 引脚 SSOP 的封装。
❐ GPIO 引脚可用做 Capsense、 LCD、模拟或数字功能
❐ 可编程驱动模式、强度和转换速率
PSoC Creator 设计环境
❐ 集成开发环境提供了原理图设计的输入和编译 （包括模拟和数字的自动布线）
❐ 用于所有固定功能和可编程外设的应用编程接口 （API 组件）
工业标准工具的兼容性
❐ 输入原理图后，可以使用基于 ARM 的工业标准开发工具进行开发
❐
❐
■
■
■
■
■
■
■
■
■
■
更多有关信息，请参考 CY8C42 系列的数据手册。
4.3.2
PSoC 5LP
板上 PSoC 5LP 用于编程和调试 PSoC 4。 PSoC 5LP 通过一个 USB Mini B 连接器与 PC 的 USB 端
口相连，另外它还连接到 PSoC 4 器件的 SWD 接口。
PSoC 5LP 是一个系统级解决方案，可在单个芯片中提供微控制器单元 （MCU）、存储器、模拟和数
字外 设 功能。 CY8C58LPxx 系列提供了一种新型的信号采集、信号处理和控制方法，并具有高精
度、高带宽 和 高灵活性等特点。其模拟功能涵盖了从热电偶信号 （接近直流电压）到超声波信号的
广泛信号范围。更多有关信息，请参考 PSoC 5LP 网页。
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特性
■
■
■
■
32 位 ARM Cortex-M3 CPU 内核
❐ 工作频率介于 DC 至 67 MHz 之间
❐ 高达 256 KB 的闪存程序存储器，包括 100,000 个写周期、 20 年保留时间和多种安全特性
❐ 高达 32 KB 闪存的纠错码 （ECC）或配置存储
❐ 高达 64 KB 的 SRAM
❐ 2 KB 可电擦除可编程只读存储器 （EEPROM）， 1M 的擦除周期以及 20 年的保留时间
❐ 包括多层 AHB 总线访问的 24 通道直接存储器访问 （DMA）
a.可编程链式描述符和优先级
b.支持高带宽 32 位传输
低电压、超低功耗
❐ 工作电压的范围广：0.5 V 到 5.5 V
❐ 高效升压调节器 （输入 0.5V，输出 1.8 V 到 5.0 V）
❐ 6 MHz 时为 3.1 mA
❐ 低功耗模式包括：
a.2 µA 睡眠模式，包含实时时钟 （RTC）和低电压检测 （LVD）中断
b.RAM 保留数据的 300 nA 休眠模式
通用的输入 / 输出系统
❐ 28 到 72 个输入 / 输出 （62 个 GPIO、 8 个 SIO、 2 个 USBIO[2]）
❐ 可以从任何 GPIO 连接至任何数字或模拟外设
❐ 所有 GPIO 都具有 LCD 直接驱动功能，最多能够驱动 46×16 段
❐ 所有 GPIO[3] 均支持 CapSense
❐ 1.2 V 到 5.5 V 输入 / 输出接口电压，多达 4 个电域
❐ 在所有引脚或端口上可屏蔽的独立 IRQ
❐ 施密特触发器晶体管 - 晶体管逻辑 （TTL）输入
❐ 所有 GPIO 均可配置为开漏高电平 / 低电平、上拉 / 下拉、高阻或强输出
❐ 在上电复位 （POR）时可配置 GPIO 引脚的状态
❐ SIO 具有 25 mA 的灌电流能力
数字外设
❐ 20 至 24 个基于可编程逻辑器件 （PLD）的通用数字模块 （UDB）
❐ Full CAN 2.0b RX 缓冲区 （16 个）和 TX 缓冲区 [2] （8 个）
❐ 使用了内部 oscillator[2] 的全速 （FS） USB 2.0 12 Mbps
❐ 四个 16 位可配置定时器、计数器和 PWM 模块
❐ 67 MHz、24 位定点数字滤波器模块（DFB），用于实现有限脉冲响应（FIR）和 无 限脉冲响
应 （IIR）滤波器
❐ 标准外设库
a.8、 16、 24 和 32 位定时器、计数器和 PWM
b.串行外设接口 （SPI）、通用异步发送接收器 （UART）和 I2C
c.目录中列出的许多其他外设
❐ 高级外设库
a.循环冗余校验 （CRC）
b.伪随机序列 （PRS）发生器
c.本地互连网络 （LIN）总线 2.0
d.正交解码器
❐ 模拟外设 （1.71 V ≤ VDDA ≤ 5.5 V）
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在 –40°C 到 +85 °C 范围内，内部参考电压为 1.024 V ±0.1%
具有 8 至 20 位分辨率的可配置 Delta-Sigma ADC
❐ 采样率最高可达 192 ksps
❐ 可编程增益级：×0.25 到 ×16
❐ 12 位模式、 192 ksps、 66 dB 信噪比和失真比 （SINAD）、±1 位 INL/DNL
❐ 16 位模式、 48 ksps、 84 dB SNR、 ±2 位 INL、 ±1 位 DNL
❐ 两个 SAR ADC，在转换速率为 1 Msps 的情况下每个 ADC 大小为 12 位
❐ 四个 8 位 8 Msps 电流 IDAC 或 1 Msps 电压 VDAC
❐ 四个响应时间为 95 ns 的电压比较器
❐ 四个驱动能力为 25 mA 的未赋定运算放大器
❐ 四个可配置的多功能模拟模块。配置示例包括可编程增益放大器 （PGA）、互阻放大器
（TIA）、混频器，以及采样和保持
❐ CapSense 支持
编程、调试和跟踪
❐ JTAG （4 线）接口、串行线调试 （SWD）（2 线）接口、单线浏览器 （SWV）以及 TRACEPORT 接口
❐ Cortex-M3 闪存修补和断点 （FPB）模块
❐ Cortex-M3 嵌入式跟踪宏单元 ™ （ETM™）可生成指令跟踪流。
❐ Cortex-M3 数据观察点和跟踪 （DWT）可生成数据跟踪信息
❐ Cortex-M3 仪器化跟踪宏单元 （ITM）可用于 printf 式调试
❐ DWT、 ETM 和 ITM 模块可通过 SWV 或 TRACEPORT 与片外调试和跟踪系统进行通信
❐ 支持通过 I2C、 SPI、 UART、 USB 以及其他接口进行 Bootloader 编程
高精度的可编程时钟
❐ 涵盖整个温度和电压范围的 3 至 62 MHz 内部振荡器
❐ 4 至 25 MHz 晶振，能够实现晶振 PPM 精度
❐ 能够生成高达 67 MHz 的内部 PLL 时钟
❐ 32.768 kHz 监视晶振
❐ 频率为 1 kHz、 33 kHz 和 100 kHz 的低功耗内部振荡器
❐
❐
■
■
更多有关信息，请参考 CY8C58LPxx 系列的数据手册。
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4.3.3
电源系统
该电路板具有通用的电源系统，所以输入电源可以来自于：
■
板上 USB 编程插座 J10 的 5 V 电源
■
使用插座 J1_01 的 Arduino 扩展板的 5 V 到 12 V 电源
■
使用插座 J6 或 J7 的板上 SWD 编程的电源 — VTARG
VIN — J11
■
PSoC 4和PSoC 5LP的电源可以为3.3 V或5 V。通过J9跳线器可以选用3.3 V或5 V。该电路板可以为
输入 / 输出插座提供 3.3 V 和 5 V 的电压，并且接收来自输入 / 输出插座的 3.3 V 电压。外部电源可
通过插座 VIN （J11）给该电路板供电，其中 VIN 的电压范围为 5 V 到 12 V。低压差电压调节器将
VIN 值调制为 3.3 V。图 4- 4 显示的是电源框图和保护电 路 。
注意 ：USB （VBUS）直接供电给 5 V 电域。因此该电域未经调节。
图 4- 4.
电源框图和保护电路
I/O Header
5V
MOSFET based Protection Ckt
D4
D1
USB
3.3V
Vin
PSoC 4
LDO
USB
5V
D2
D3
J9
PSoC 5LP
PTC
ESD
Protection
P4 10pin
Debug
P5LP 10pin
Debug
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4.3.3.1
保护电路
该电路具有反向电压、过电压、短路和过电流保护等功能，如图 4- 4 所示。
4.3.3.2
■
肖特基二极管 （D1）确保不会通过输入 / 输出插座供电给 5 V 电域。
■
保护二极管 （D2）确保不会通过 VIN （来自输入 / 输出插座的电源）供电给 USB。
■
肖特基二极管 （D3）确保不会通过输入 / 输出插座中的 3.3 V 电源供电给 LDO。
■
保护二极管 （D4）确保 VIN 不为电压调节器的输入提供反向电压。
■
通过与 PTC 恢复式保险丝相连接，计算机的 USB 端口可以避免发生短路和过电流情况。
■
基于 MOSFET 的保护电路为 3.3 V 电源导轨提供过电压和反向电压的保护。PMOS Q1 为电路板上
的各组件防止反向电压状态。 PMOS Q2 为 PSoC 防止过电压状态。当电压超过 4.2 V 时，
PMOS Q2 将关闭以保护 PSoC 4。
■
调整 LDO 的输出电压，以便在减去肖特基二极管上的电压降时，它将提供 3.3 V。
测量 PSoC 4 电流消耗的过程
为 PSoC 4 器件测量电流消耗时，可以使用下面三个方法。
1. 当该电路板由 USB 端口 （J10）供电时，移除跳线器 J13 并连接到电流表，如图 4- 5 所示。
图 4- 5.
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PSoC 4 由 USB 端口供电时的电流测量
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2. 当同时使用 USB 和独立电源供电给 PSoC 4 电路板时（USB 上的电压调节器输出必须在独立电源
±0.5 V 的范围内）。
移除跳线器 J13。将供电电压的正端连接到电流表的正端，并将该电流表的负端连接到跳线器
J13 的更低引脚。图 4- 6 显示的是要求的各个连接。
图 4- 6.
单独供电给 PSoC 4 时的电流测量
VOLTAGE
SOURCE
3. 单独供电给 PSoC 4 供，且未给 PSoC 5LP 供电时，为了避免测量电流时发生漏电情况，用户必须
进行下列操作：
■
移除零欧姆电阻 R24 及 R25。这样将会影响到 USB-I2C 的功能。
■
移除用于编程 PSoC 4 的 R32、 R33 和 R34。这样将禁用 PSoC 5LP 的编程功能。
■
使用一个电流表从插座 J13 的引脚 1 连接到它的引脚 2 进行测量电流。
图 4- 7.
4.3.4
电路板上零欧姆电阻的位置
编程接口
该套件允许在两种模式下对 PSoC 4 进行编程与调试：
■
使用板上 PSoC 5LP 编程器和调试器
■
使用 CY8CKIT-002 MiniProg3 编程器和调试器
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4.3.5
Arduino 兼容插座 （J1、 J2、 J3、 J4 及 J12 — 未组装）
该套件具有五个 Arduino 兼容插座：J1、 J2、 J3、 J4 及 J12。用户可以根据 Arduino 扩展板的硬件
来开发各应用。
J1 插座包含用于复位、内部参考电压（IOREF）和电源线的输入 / 输出引脚。J2 插座是一个模拟端口。
它包含用于 SAR ADC、比较器和运算放大器的输入 / 输出引脚。 J3 插座主要作为一个数字端口。它
包含用于 PWM、 I2C、 SPI 和模拟参考的输入 / 输出引脚。 J4 插座也是一个数字端口。它包含用于
UART和PWM的输入/输出引脚。J12插座是一个用于SPI接口的Arduino ICSP兼容插座。该插座未被
组装。请参考插座部件编号的附录中第 102 页上的物料清单（BOM）章节 的 “ 空载组件 ” 部分。
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图 4- 8.
Arduino 兼容插座
Arduino TM
Compatible
I/O Header (J4)
Arduino TM
Compatible
I/O Header (J3)
Arduino TM
Compatible ICSP
I/O Header (J12)
Arduino TM
Compatible
I/O Header (J2)
Arduino TM
Compatible
I/O Header (J1)
P4_VDD
0603
R8
2.2K
I2C Pull up
R9
2.2K Resistors
0603
TVS4
18V 350W BI
J3
VBUS
VIN
P4_0
P4_1
J1
1
2
3
4
5
6
7
8
D4
SOD123
V3.3_EXT
/XRES
IOREF
P4_VDD
10
9
8
7
6
5
4
3
2
1
P1_7
P0_6
P3_1
P3_0
P3_4
P3_6
P2_6
8x1 RECP
10X1 RECP
J2
P2_0
P2_1
P2_2
P2_3
P2_4
P2_5
P0_0
P0_1
P1_0
1
3
5
7
9
11
13
15
17
2
4
6
8
10
12
14
16
18
P0_2
P0_3
P1_5
P1_4
P1_3
P1_2
P1_1
9x2 RECP
P4_VDD
J4
P0_4
P0_5
P0_7
P3_7
P0_0
P3_5
P1_0
P2_7
1
2
3
4
5
6
7
8
P4_VDD
J12
P3_1
P0_6
/XRES
1
3
5
2
4
6
P3_0
3x2 RECPT
NO LOAD
8x1 RECP
(J1-J4) Arduino Compatible Headers
4.3.5.1
插座 J2 的其他功能
J2插座是支持Arduino扩展板的一个9x2插座。PSoC 4的端口0、端口1和端口2引脚被连接到此插座。
端口 1 引脚还可以使用 560 欧姆电阻与板上的 CapSense 滑条相连。如果 CapSense 特性不被使用，
移除这些电阻来保证这些引脚的更好性能。
4.3.5.2
未组装插座 J12 的功能
J12 插座是一个支持 Arduino 扩展板的 2 x 3 插座。可在小的子集屏蔽上使用该插座，并且可以在 PSoC
4 Pioneer 套件上未组装它。请注意，J12 插座只能在 5.0 V 模式下运行。为了保证屏蔽的正常功能，用
户需要确保在 5.0 V 模式下连接电源跳线器。
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4.3.6
Digilent Pmod 兼容插座 （J5 — 未组装）
该端口支持 Digilent Pmod 外设模块。 Pmod 是小型的输入 / 输出接口。 Pmod 端口通过 6 或 12 引
脚连接器连接至嵌入式控制电路板。 PSoC Pioneer 套件支持 6 引脚的 Pmod 类 2 （SPI）接口。有
关 Digilent Pmod 卡的详细信息，请参见 www.digilentinc.com。
此插座在 PSoC 4 Pioneer 套件上未组装。连接 PMod 子卡之前，用户需要组装好此插座。
图 4- 9.
36
Pmod 的连接
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此插座在 Pioneer 套件上未组装。请参考插座部件编号的附录中第 102 页上的物料清单 （BOM）章
节 的 “ 空载组件 ” 部分。
图 4- 10.
Digilent PMOD 接口
J5
P4_VDD
P3_5
P3_0
P3_1
P0_6
1
2
3
4
5
6
6X1 CONN FEMALE
NO LOAD
J5 Digilent PMOD Cards
Compatible Headers
有关 J5 插座引脚说明的详细信息，请参见第 98 页上的引脚分配表章节 。
4.3.7
PSoC 5LP GPIO 插座 （J8）
PSoC 5LP的有限引脚集被连接到该插座。请参考第 78页上的开发PSoC 5LP的应用程序章节 ，以便
开发制定应用。请参考引脚详细的附录中第 98 页上的引脚分配表章节 。
图 4- 11.
PSoC 5LP GPIO 插座 （J8）
P5LP_VDD
J8
P5LP0_0
P5LP3_4
P5LP3_6
P5LP12_6
1
3
5
7
9
11
2
4
6
8
10
12
P5LP1_2
P5LP0_1
P5LP3_5
P5LP3_7
P5LP12_7
P5LP3_0
6x2 RECPT
PSoC 5LP GPIO Extension Header
CY8CKIT-042 PSoC 4 Pioneer 套件指南，文档 # 001-90179 Rev. **
37
硬件
4.3.8
CapSense 滑条
板上的套件具有 5 段线性电容的触摸滑条。此触摸滑条连接到 PSoC 4 器件的引脚 P1[1]–P1[5]。
Cmod （调制电容）被连接到引脚 P4[2]，并且可以选择和一个泄放电阻 （R1）进行连接。此板支持
具有防水性能的 CapSense 的设计。
防水设计采用一个概念为放置在传感器周围的导线的屏蔽。此屏蔽必须连接到器件上指定的屏蔽引
脚，以便执行此屏蔽。当未使用时，需要将它接地。在 PSoC 4 Pioneer 套件中，分别通过电阻 R44
和 R45 来实现此屏蔽与引脚或地的连接。默认的情况下， R45 被安装在连接屏蔽地的电路板上。当
评估防水设计时组装 R44。 R44 会将屏蔽连接到指定的引脚， P0[1]。此屏蔽与 “Arduino 扩展板 ”
不同（通过 Arduino 插座连接的电路板）。有关 CapSense 的详细信息，请参考 CapSense 设计指南。
P1_5
P1_4
CapSense 滑条的连接
P1_3
图 4- 13.
P1_2
CapSense 滑条
P1_1
图 4- 12.
Shunt
Resistor
NO LOAD
P4_2
R44 ZERO
P0_1
Shield
0603
1
560 ohm
2
560 ohm
3
560 ohm
4
560 ohm
5
560 ohm
R17 R18 R19 R20 R21
R1
NO LOAD
C1
2200 pF
R45 ZERO
CSS1
0603
CapSense Slider 5 Seg
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CAPSENSE TUNING CIRCUITRY
Default Loaded For CSD
Shield Setting
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4.3.9
Pioneer 电路板 LED
PSoC 4 Pioneer 电路板具有 3 个 LED。一个绿色 LED（D10）指示编程器的状态。有关 LED 指示的详
细表，请参考 A.5 固件中的错误 / 状态 LED 中的状态指示。 一个琥珀色的 LED （D3）用于指示电
路板的电源供电状态。套件还有一个用于用户应用场合的通用三色 LED （D9），它被连接至 PSoC 4
的特定引脚。
图 4- 14 显示的是上述板上 LED 的指 示 。图 4- 15 和图 4- 16 详细介绍了 LED 的原理图。
图 4- 14.
Pioneer 套件 LED
图 4- 15.
状态 LED 和电源 LED
P5LP_VDD
R31
VDD
D10
2
1
2
0805
1
0805
0805
330 ohm
图 4- 16.
D3
R3 560 ohm
P5LP3_1
Status LED Green
Power LED
RGB LED
D9
R28
P1_6
2.2K
1
P4_VDD
R29
1.5K
R30
1.5K
4
R
G
2
P0_2
3
P0_3
B
RGB LED
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4.3.10
按键
该套件包括一个复位按键和一个用户按键，如图 4- 17 所示。
复位按键被连接到 PSoC 4 的 XRES 引脚，并用于复位 PSoC 4 的板上器件。用户按键被连接到 PSoC
4 器件的 P0[7]。在工作模式下，如低电平有效模式，上述的两个按键都接地。
图 4- 17.
按键
SW1
/XRES
1
2
EVQ-PE105K
RESET
SW2
P0_7
1
2
EVQ-PE105K
USER BUTTON
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5.
示例项目
本节所描述的示例项目向用户介绍了 PSoC 4 器件和板上组件的功能。
可以从套件的网页载本节所描述的代码示例。
按照下面步骤来打开并编程代码示例：
1. 启动 Start 菜单中的 PSoC Creator。
2. 在 Examples and Kits > Find Example Project > Kits > CY8CKIT-042 的下面单击 <Project.cywrk> 就可以打开示例项目。
图 5- 1.
从 PSoC Creator 打开示例项目
3. 依次选择 Build > Build <Project name> 来编译代码示例，并生成 hex 文件。
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图 5- 2.
从 PSoC Creator 中编译项目
4. 要编程项目，使用 USB 线缆 （连接到端口 J10）将电路板连接到计算器，如 3.1 Pioneer 套件的
USB 接口。电路板被检测为 KitProg。
5. 从 PSoC Creator 选择 Debug > Program。
图 5- 3.
编程 PSoC Creator 中的器件
6. 如果还没获取器件， PSoC Creator 将打开编程窗口。选择 KitProg/，然后单击 Port Acquire 按
键。
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图 5- 4.
获取 PSoC Creator 中的器件
7. 器件获取后， KitProg 下面显示属性结构。现在，点击 Connect 按键。
图 5- 5.
连接到 PSoC Creator 中的器件
8. 点击 OK 退出窗口并开始编程。
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图 5- 6.
44
编程 PSoC Creator 中的器件
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5.1
项目：闪烁 LED
5.1.1
项目描述
该示例代码使用脉冲宽度调制器 （PWM）来点亮 RGB LED。 PWM 的输出将连接到 RGB LED 的引
脚 P0_3（蓝）。闪炼频率被置为 1 Hz，占空比为 50%。闪炼频率和占空比分别取决于周期和比较值。
注意：PSoC 4 Pioneer 套件的该示例是出厂时设置的。
图 5- 7.
5.1.2
闪炼 LED 项目的 PsoC Creator 原理图设计
硬件连接
该项目不要求硬件连接，因为所有连接在电路板上都是硬连接的。在工作区浏览器中打开 Blinking
LED.cydwr 并选择适用的引脚。
表 5- 1.
引脚连接
引脚名称
PWM
端口名称
P0_3 (Blue)
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图 5- 8.
5.1.3
闪炼 LED 项目的引脚选择
流程图
图 5- 9 显示的是在 main.c 中执行 代 码的流程图。
图 5- 9.
5.1.4
闪炼 LED 项目的流程图
验证输出项
在器件上编译并编程代码示例。查找闪炼 LED 的频率和占空比。在 PWM 组件内更改周期值和比较
值，如图 5- 10 所示。重新编译和编程器件以确定频率和占空比。
46
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图 5- 10.
PWM 组件的配置窗口
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5.2
项目：PWM
5.2.1
项目描述
该示例项目介绍了 PWM 组件的使用。该项目使用三个 PWM 来设置 Pioneer 套件上 RGB LED 的颜色。
LED 的颜色周期经过七种颜色，即紫 > 靛蓝 > 蓝 > 绿 > 黄 > 橘 > 红 (VIBGYOR)。每种颜色的
保留时间为 1 秒钟。颜色的不同取决于 PWM 脉冲宽度的改变。
图 5- 11.
5.2.2
PWM 项目的 PSoC Creator 原理图设计
硬件连接
该项目不要求硬件连接，因为所有连接在电路板上都是硬连接的。在工作区浏览器中打开 PWM.cydwr
并选择适用的引脚。
表 5- 2.
引脚连接
引脚名称
48
端口名称
PWM1
P1_6 (Red)
PWM2
P0_2 (Green)
PWM3
P0_3 (Blue)
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图 5- 12.
5.2.3
PWM 项目的引脚选择
流程图
图 5- 13 显示的是 C 中执行代码的流程 图 。
图 5- 13.
PWM 的流程图
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5.2.4
验证输出项
编译并编程代码示例，然后复位器件。通过颜色模式来观察 RGB LED 周期。
50
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5.3
项目：深度睡眠
5.3.1
项目描述
该项目介绍了 PSoC 4 的低功耗功能。LED 只在一秒中亮着以表示器件进入了有效状态，然后马上处
于深度睡眠状态。按下SW2开关后，器件被唤醒，LED在一秒中闪亮，然后器件又返回深度睡眠模式。
图 5- 14.
5.3.2
深度睡眠项目的 PSoC Creator 原理图设计
硬件连接
该项目不要求额外的硬件连接，因为所有连接在电路板上都是硬连接的。要想通过该项目进行低功耗
测量，请参考第 32 页上的 4.3.3.2 测量 PSoC 4 电流消耗的过程 节所详细描述的场合。
在工作区浏览器中打开 Deep Sleep.cydwr 选择适用的引脚。
表 5- 3.
引脚连接
引脚名称
端口名称
LED
P1_6 (Red)
Switch
P0_7
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图 5- 15.
5.3.3
深度睡眠项目的引脚选择
流程图
图 5- 16 显示的是在 C 中执行代码的流程图。
图 5- 16.
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深度睡眠的流程图
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5.3.4
验证输出项
编译并编程代码示例，然后重置器件。 LED 只在一秒内闪亮然后关闭，表示器件已进入深度睡眠模
式。 按下 SW2 开关来唤醒器件，并使其进入活动模式。一秒后，器件将返回睡眠模式。
注意：当器件进入深度睡眠模式时，在开始编程之前，编程员需要重新获取器件。
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5.4
项目：CapSense
5.4.1
项目描述
该示例项目介绍了PSoC 4的CapSense。它使用电路板上的5段CapSense滑条。 通过使用CapSense
组件上所执行的赛普拉斯 CapSense Sigma Delta (CSD) 算法来扫描电容式传感器。 有关 CapSense
组件和 CapSense 调试的更多信息，请参考 PSoC Creator 中的 《CapSense 组件数据手册》。
在本示例项目中， LED 的绿色和红色的显示取决于用户手指在 CapSense 滑条的位置。
图 5- 17.
5.4.2
CapSense 项目的 PSoC Creator 原理图设计
硬件连接
该项目不要求硬件连接，因为所有连接在电路板上都是硬连接的。在工作区浏览器中打开 CapSense.cydwr 并选择适用的引脚。
表 5- 4.
引脚连接
引脚名称
端口名称
P1_1 Segment1
CapSense Linear
Slider
P1_2 Segment2
P1_3 Segment3
P1_4 Segment4
P1_5 Segment5
LEDs
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P1_6(Red) and P0_2(Green)
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图 5- 18.
5.4.3
CapSense 项目的引脚选择
流程图
图 5- 19 显示的是在 C 中执行代码的流程图。
图 5- 19.
CapSense 的流程图
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5.4.4
验证输出项
LED 的绿色和红色的显示取决于用户手指在 CapSense 滑条的位置。当手指位于滑条的段 5（P1[5]），
绿 LED 的亮度亮于红 LED。当手指位于段 1 （P1[1]） ，红 LED 则亮于绿 LED。
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6.1
高级部分
将 PSoC 5LP 作为 USB-UART 桥接器使用
将 PSoC 5LP 作为 USB-UART 桥接器使用，用于同 COM 终端软件进行通信。此部分说明了如何创建
一个 PSoC 4 示例项目，用于同 COM 终端软件进行通信。 PSoC 4Pioneer 套件中的该项目及其他示
例项目都位于 element14 网页上， 100 个项目在 100 天内 。
如果用户使用了不包含超级终端的 Windows 操作系统，那么，可采用备用的终端软件，如 PuTTy 。
1. 在 PSoC Creator 中，打开一个新的 PSoC 4 项目。
图 6- 1.
从 PSoC Creator 中打开新项目
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2. 将 UART(SCB) 组件拖放到 TopDesign 上。
图 6- 2.
组件目录下的 USB 组件
3. 要想配置 UART，请双击该组件或右键点击它并选择 Configure。
图 6- 3.
58
打开 UART 配置窗口
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4. 配置 UART，如下面各个图片所示。
图 6- 4.
UART 基本配置窗口
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图 6- 5.
UART 高级配置窗口
5. 在 <Project.cydwr> 的 Pins（引脚）选项卡下，分别为 UART RX 和 UART TX 选择 P0[4] 和 P0[5] 引
脚。
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图 6- 6.
引脚选择
6. 将以下代码放入您的 main.c 项目文件内。
#include <device.h>
void main()
{
uint8 ch;
/* Start SCB UART TX+RX operation */
UART_Start();
/* Transmit String through UART TX Line */
UART_UartPutString("CY8CKIT-042 USB-UART");
for(;;)
{
/* Get received character or zero if nothing has been received yet
*/
ch = UART_UartGetChar();
if(0u != ch)
{
/* Send the data through UART. This functions is blocking and waits until
there is an entry into the TX FIFO. */
UART_UartPutChar(ch);
}
}
}
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7. 通过依次选择 Build > Build {Project Name} 或按组合键 [Shift] + [F6]，可以编译项目。项目编译
无误或无警告后，通过 PSoC 5LP USB 编程器或 MiniProg3，（依次点击 Debug > Program）将
该项目编程到 PSoC 4 内。
将 PSoC 4 上的 RX 线连接到 J8_10，并将 PSoC 4 的 TX 线连接到 J8_9，如下图所示。
图 6- 7.
PSoC 4 与 PSoC 5LP 之间使用 UART 进行连接
图 6- 8.
PSoC 4 与 PSoC 5LP 之间使用 UART 进行连接的框图
J8_9
J8_10
P12[7]
P12[6]
UART RX UART TX
USB
Mini B
D+
D-
P15[6]
P15[7]
PSoC 5LP
P0[4]
UART RX
P0[5]
UART TX
PSoC 4
注意：根据 UART 组件的配置情况，可将 UART RX 和 UART TX 路由到 PSoC 4 上的任何数字引脚。
通过 UART 的 SCB 执行，可将 RX 和 TX 引脚路由到下面任何一个子集：（P0[4]、P0[5]）、（P3[0]、
P3[1]）或 （P4[0]、 P4[1]）。
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要想 COM 终端软件同 PSoC 4 通信，请按照以下流程进行操作：
1. 将 USB Mini 微型 B 连接到 J10。该套件将枚举为 KitProg USB-UART，并显示在器件管理程序
Ports (COM & LPT) 中。将一个通信端口分配给 KitProg USB-UART。
图 6- 9.
器件管理程序中的 KitProg USB-UART
2. 打开超级终端并依次选择 File > New Connection，然后输入新连接的名称，最后点击 OK。
对于 PuTTY，双击 PuTTY 图标并选择 Connection 下的 Serial 项。
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图 6- 10.
打开新的连接
Hyperterminal:
PuTTY:
3. 一个新窗口被打开，可在这里可以选择通信端口。
在超级终端中，选择 ‘Connect using’ 的 COMX （或分配给 KitProg USB-UART 的特定通信
端口），然后点击 OK。
在 PuTTY 配置中 ‘Serial line to connect to’ 项旁边的文本框内键入 COMX。
此示例项目将使用 COM12。
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图 6- 11.
选择通信端口
Hyperterminal:
图 6- 12.
选择通信端口 — PuTTY
4. 在超级终端中，分别选择 ‘Port Settings' 标签下与 ‘Bits per second'、‘Data
bits'、‘Parity'、‘Stop bits' 以及 ‘Flow controlll' 相应的设置，然后点击 OK。
请确保该设置与 PSoC 4 中所配置的 UART 设置相同。
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在 PuTTY 的 ‘Configure the serial line’ 下，分别为 ‘Speed (baud)’、‘Data bits’、‘Stop
bits’、‘Parity’以及‘Flow control’选择相应的设置。点击‘Session’，然后选择‘Connection
type’ 下的 ‘Serial’ 项。
‘Serial line’ 显示的是所选定的通信端口 (COM12)，‘Speed’ 显示的是所选的波特率。点击
Open 以启动通信过程。
图 6- 13.
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配置通信端口 — 超级终端：
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图 6- 14.
配置通信端口 — PuTTY:
图 6- 15.
在 PuTTY 中选择通信类型
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5. 依次选择 File > Properties > Settings > ASCII Setup 后，通过使能 Echo typed characters
locally，可以在超级终端中显示所输入的字符。在 PuTTY 中，使能 Terminal > Line discipline 选
项下的 Force on，可显示在 PuTTY 中所输入的字符。
图 6- 16.
使能在超级终端中所输入字符的回送
图 6- 17.
使能在 PuTTY 中所输入字符的回送
6. COM 终端软件显示了来自 PSoC 4 中 UART 的键入数据和回环数据。
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图 6- 18.
超级终端上所显示的数据
图 6- 19.
数据在 PuTTY 上显示
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6.2
将 PSoC 5LP 作为 USB-I2C 桥接器使用
PSoC 5LP作为一个USB-I2C桥接器使用，因此，可以使用它与PC上运行的USB-I2C软件通信。PSoC
4Pioneer 套件中的该项目及其他示例项目都位于 element14 网页上， 100 个项目在 100 天内。
下面仔细解释了 USB-I2C 桥接器的使用，它可以与 BCP 和 PSoC 4 进行通信。
1. 在 PSoC Creator 中打开面向 PSoC 4 的新项目。
图 6- 20.
在 PSoC Creator 中打开新项目
2. 将一个 I2C 组件拖放到 TopDesign 上。
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图 6- 21.
组件目录中 I2C 组件
3. 要想配置 I2C 组件，请双击该组件或右键点击它并选择 Configure。
图 6- 22.
打开 I2C 配置窗口
4. 按照下面介绍的设置对 I2C 进行配置。
CY8CKIT-042 PSoC 4 Pioneer 套件指南 , 文档 # 001-90179 Rev. **
71
高级部分
图 6- 23.
I2C 配置窗口
5. 在 <poject.cydwr> 的 Pins（引脚）选项卡下为 I2C SCL 选择 P3[0] 引脚，为 I2C SDA 选择 P3[1] 引
脚。
图 6- 24.
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引脚选择
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6. 将以下代码放入您的 main.c 项目文件中。该代码允许在 PSoC 4 器件与 BCP 应用之间发送和接收
I2C 数据。
#include <device.h>
void main()
{
uint8 wrBuf[10];
uint8 rdBuf[10];
uint8 indexCntr;
uint32 byteCnt;
/* I2C write buffer */
/* I2C read buffer */
/* Enable the Global Interrupt */
CyGlobalIntEnable;
/* Start I2C Slave operation */
I2C_Start();
/* Initialize write buffer */
I2C_I2CSlaveInitWriteBuf((uint8 *) wrBuf, 10);
/* Initialize read buffer */
I2C_I2CSlaveInitReadBuf((uint8 *) rdBuf, 10);
for(;;) /* Loop forever */
{
/* Wait for I2C master to complete a write */
if(0u != (I2C_I2CSlaveStatus() & I2C_I2C_SSTAT_WR_CMPLT))
{
/* Read the number of bytes transferred */
byteCnt = I2C_I2CSlaveGetWriteBufSize();
/* Clear the write status bits*/
I2C_I2CSlaveClearWriteStatus();
/* Move the data written by the master to the read buffer so that the
master can read back the data */
for(indexCntr = 0; indexCntr < byteCnt; indexCntr++)
{
rdBuf [indexCntr] = wrBuf[indexCntr]; /* Loop back the data to the read
buffer */
}
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/* Clear the write buffer pointer so that the next write operation will
start from index 0 */
I2C_I2CSlaveClearWriteBuf();
/* Clear the read buffer pointer so that the next read operations starts
from index 0 */
I2C_I2CSlaveClearReadBuf();
}
/* If the master has read the data , reset the read buffer pointer to 0
and clear the read status */
if(0u != (I2C_I2CSlaveStatus() & I2C_I2C_SSTAT_RD_CMPLT))
{
/* Clear the read buffer pointer so that the next read operations starts
from index 0 */
I2C_I2CSlaveClearReadBuf();
/* Clear the read status bits */
I2C_I2CSlaveClearReadStatus();
}
}
}
7. 通过依次点击 Build > Build Project 或按组合键 [Shift]+[F6]，可以编译项目。编译项目无误或无警
告后，通过 PSoC 5LP 编程器或 MiniProg3，（按组合键 [Ctrl]+[F5]）将该代码编程到 PSoC 4
内。
8. 依次选择 Start > All Programs > Cypress > Bridge Control Panel<version number>，打开
BCP
9. 连接到 Connected I2C/SPI/RX8 Ports 下的 KitProg/。
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图 6- 25.
连接到 BCP 中的 KitProg/
10.从 Tools 菜单中打开 Protocol configuration，然后选择相应的 I2C speed。请确保该 I2C 速度与
I2C 组件中所配置的速度相同。点击 OK，关闭该窗口。
图 6- 26.
打开 BCP 中的协议配置窗口
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11. 从 BCP 从器件中地址为 0x08 上的五个数据字节传送到 I2C 器件。记录显示了传输操作是否成功。
每个字节后显示的 ‘+’ 指示表示操作已成功，而 ‘-’ 指出操作失败。
图 6- 27.
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在 BCP 中输入指令
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图 6- 28.
BCP 中的 NACK 指示
12.从 BCP 读取来自 I2C 从器件的五个数据字节（从器件地址为 0x08）。记录显示了传输操作是否成
功。
图 6- 29.
从 BCP 中读取数据字节
注意：请参见 BCP 中 “ 帮助内容 ” 或 “ 帮助 ” 下的 [F1]，了解 I2C 指令的细节。
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6.3
开发 PSoC 5LP 的应用程序
PSoC 4 Pioneer 套件具有一个板上 PSoC 5LP，其主要功能是作为编程器和桥接器使用。此外，用户
还可以为 PSoC 5LP 构建一个独立的应用程序。用户通过使用 PSoC 5LP，可以构建普通项目，也可
以构建 Bootloadable 项目。
有关 Pioneer 电路板上 PSoC 5LP 的连接，汇总在第 78 页中的图 6- 30 内。
J8 是 I/O 连接器 （参见 4.3.7 PSoC 5LP GPIO 插座 （J8）一节。
已连接 USB （J10），并作为 PC 接口使用。但是用户仍可以使用该 USB 连接创建定制 USB 设计。
编程插头 （J7）用于独立编程目的。需要填充该插头。参见第 102 页上的 A.6 物料清单 （BOM）的
‘ 空载组件 ’ 部分内容。
图 6- 30.
PSoC 5LP 结构框图
D+
P15_6
Mini USB (J10)
P15_7
D-
10-pin SWD
programming
and debugging
header
(J7)
SWDIO
P1_0
SWDCLK
P1_1
SWO
P1_3
TDI
P1_4
XRES
XRES
P1_2
PSoC 5LP
P0_0
P0_1
P3_4
P3_5
P3_6
P3_7 P12_6 P12_7 P3_0
J8_2
J8_3
J8_4
PSoC 5LP
I/O Header
(J8)
J8_5
J8_6
J8_7
J8_8
J8_9
J8_10
J8_12
6.3.1
为 PSoC 5LP 构建 Bootloadable 项目
面向 PSoC 5LP 开发的所有 Bootloadable 应用程序需要基于套件上所编程的 Bootloader 十六进制文
件。 Bootloader 的十六进制文件可在套件文件使用，或可从套件网页下载。
十六进制文件位于以下套件安装程序目录中：
<Install Path>\CY8CKIT-042 PSoC 4 Pioneer Kit\
<version>\Firmware\Programmer\KitProg_Bootloader
图 6- 31.
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KitProg Bootloader .hex 文件的位置
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按照以下程序为 PSoC 5LP 构建所需要的 Bootloadable 应用：
1. 先打开 PSoC Creator，依次选择 New > Project > PSoC 5LP，然后点击 Advanced 项旁边的扩展
按钮，将 Device 设为 CY8C5868LTI-LP039，如第 80 页中的图 6- 33 所示，同时，将 Application type 设为下拉列表中的 Bootloadable 项。
图 6- 32.
在 PSoC Creator 中打开新项目
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图 6- 33.
选择 PSoC Creator 中的器件
2. 导航到原理图窗口并将 Bootloadable 组件拖放到顶层设计内。
图 6- 34.
组件目录中的 Bootloadable 组件
通过选择配置窗口中的 Dependencies 标签并点击 Browse 按键，可以设置 Bootloadable 组件的依
赖关系。选择 KitProg_Bootloader.hex 文件并点击 Open。
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图 6- 35.
Bootloadable 组件的配置窗口
图 6- 36.
选择 KitProg Bootloader hex 文件
3. 开发您的自定义项目。
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4. Bootloadable 项目的 NVL 设置必须与 KitProg_Bootloader 项目的相同。下图显示了 KitProg_Bootloader.cydwr 系统的设置情况。
图 6- 37.
KitProg Bootloader 系统设置
5. 通过依次选择 Build > Build Project 或按组合键 [Shift]+[F6]，可以编译所需的项目。
6. 要想将该项目下载到 PSoC 5LP 器件上，请通过依次选择 PSoC Creator select > Tools > Bootloader Host 打开 Bootloader 主机工具。
图 6- 38.
从 PSoC Creator 打开 Bootloader 主机工具
7. 在 Bootloader 主机工具中，点击 Filters 并添加一个滤波器，以确认 USB 器件。将 VID 设为
0x04B4， PID 设为 0xF13B，然后点击 OK。
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图 6- 39.
Bootloader 主机工具中的 Port Filters 选项卡
8. 在 Bootloader 主机工具中点击 Open File 按键以浏览到 Bootloadable 文件 （*.cyacd）所在的位
置。
图 6- 40.
在 Bootloader 主机工具中打开 Bootloadable 文件
9. 现按住复位开关 （SW1）并插入 USB Mini-B 连接器。若按住开关的时间超过 100 毫秒， PSoC
5LP 将进入 Bootloader。这时，按下 Bootloader Host 工具中的 Program 按键，对器件进行编程。当
拨出 PSoC 4 (J13) 的供电跳线并将 USB Mini-B 连接器插入 J10 插头时， PSoC 5LP 也会进入
Bootloader。
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图 6- 41.
从 Bootloader Host 工具中选择 Bootloadable .cyacd 文件
10.若引导加载成功，工具记录将显示 “Successful”，如果引导加载失败，则显示 “Failed”，并显
示一条失败语句。
注意：
1. PSoC 5LP 的引脚被连接到 PSoC 5LP GPIOFailed(J8) 上。这些引脚用来支持高性能的模拟和数字
项目。请参见第 98 页上的 A.2 引脚分配表 ，了解有关引脚的信。
2. 当给自定义应用程序分配 PSoC 5LP 的引脚时，应格外注意。 例如，P2 [0] - P2 [4] 是专用于编程
PSoC 4 的。在对引脚进行分配前，请参见第 95 页上的 A.1 CY8CKIT-042 原理图中的内容。
3. 当将某个普通项目编程到PSoC 5LP内时，该PSoC 5LP的初始功能，即作为编程器/USB-UART桥
接器 /USB-I2C 桥接器使用，将无效。
4. 除非自定义项目使用了状态 LED，否则该状态 LED 不会运作。
更多有关 Bootloader 和 USB Bootloader 应用程序的信息，请参见 AN73503 — 赛普拉斯 PSoC 3 和
PSoC 5LP 的 USB HID Bootloader 应用笔记。
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6.3.2
构建 PSoC 5LP 的普通项目
普通项目是指用户在 CY8CKit-042 中为 PSoC 5LP 器件创建的全新项目。用户对 PSoC 5LP 上整个
闪存进行编程，包括覆盖所有的 Bootloader 并编程代码。要想恢复编程器，用户需要通过随套件安装
程序附带的出厂设置 KitProg.hex 文件，以重新 编 程 PSoC 5LP 器件。
该出厂 KitProg.hex 文件位于套件安装程序中的安装目录内，目录路径如下：
<Install Path>/CY8CKIT-042 PSoC 4 Pioneer Kit\<version>\Firmware\Programmer\KitProg
该高级功能要求一个不属于此套件的 MiniProg3 编程器。
可从下面的网站上购买 MiniProg3：
www.cypress.com/go/CY8CKit-002
要想为 PSoC 5LP 构建一个普通项目，请按照下面流程进行操作。
1. 先打开 PSoC Creator，依次选择 New > Project > PSoC 5LP，然后点击 Advanced 旁边的扩展按
钮。分别将 Device 和 Application type 设置为相应下拉列表中的 CY8C5868LTI-LP039 和
Normal。
图 6- 42.
在 PSoC Creator 中打开新项目
2. 开发您的自定义项目。
3. 通过依次选择 Build > Build Project 或按组合键 [Shift]+[F6]，可以编译所需的项目。
4. 将 MiniProg3 的 10 引脚连接器连接到 （需要填充的）板上的 10 引脚 SWD 调试和编程插头 J7。
5. 要想通过 PSoC Creator 编程 PSoC 5LP，请依次点击 Debug > Program 或按组合键 [Ctrl]+[F5]。编
程窗口将显示 MiniProg3 和项目 （CY8C5868LTI-LP039）中所选定的器件。
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6. 先点击该器件再点击 Connect，以进行编程。
注意：
1. 尚未填充 10 引脚 SWD 调试和编程插头 （J7）。更多有关信息，请参见附录部分 A.6 物料清单
（BOM）中 ‘ 空载组件 ’ 的内容。
2. PSoC 5LP 的引脚被连接到 PSoC 5LP GPIO 插头（J8）上。这些引脚用于支持高性能的模拟和数
字项目。更多有关引脚的信息，请参见附录部分 A.2 引脚分配表 中 的内容。
3. 当给自定义应用程序分配 PSoC 5LP 的引脚时，应格外注意。例如， P2 [0] - P2 [4] 是专用于编程
PSoC 4 的。在对引脚进行分配前，请参见附件部分 A.1 CY8CKIT-042 原理图中的内容。
4. 当将某个普通项目编程到 PSoC 5LP 内时，该 PSoC 5LP 的初始功能（即作为编程器 /USB-UART
桥接器 /USB-I2C 桥接器使用）都将无效。
5. 除非自定义项目使用状态 LED，否则该状态 LED 不会工作。
6.4
PSoC 5LP 出厂设置恢复说明
PSoC 4Pioneer 套件（CY8CKIT-042）包含一个带有出厂设置的 PSoC 5LP 器件。该器件可作为 PSoC
4 器件的板上编程器和调试器使用。
除了为 PSoC 4 器件创建应用程序外，用户亦可在本套件上创建 PSoC 5LP 器件的自定义应用程序。
用户可为 PSoC 5LP 器件创建一个 Bootloadable 或一个标准的应用程序。更多详细信息，请参见第 78
页上的 6.3 开发 PSoC 5LP 的应用程序一节。通过新的闪存映像重新编程或引导加载 PSoC 5LP 器件
时，出厂设置将被覆盖掉，同时会失去将 PSoC 5LP 器件作为 PSoC 4 编程器 / 调试器使用的能力。
要想恢复 PSoC 5LP 的出厂设置并使能编程器 / 调试器的功能，请执行下面各操作。
6.4.1
恢复 PSoC 5LP 的出厂设置
若通过 Bootloadable 应用程序编程 PSoC 5LP，用户可以使用以下某一个方法恢复出厂设置。
6.4.1.1
使用 PSoC 编程器恢复 PSoC 5LP 出厂设置
1. 从 Cypress > PSoC Programmer 启动菜中启动 PSoC 编程器 3.18 或更高版本。
2. 在服务模式中配置 Pioneer 套件 — 当按住复位按键 （“SW1 Reset”）时，使用所包含的 USB
电缆 （USB A 到 USB 微型 B）将 PSoC 4 Pioneer 套件插入电脑。如此操作将使 PSoC 5LP 进
入服务模式，其状态由闪炼的绿色状态 LED 显示。
3. 以下信息显示在 PSoC 编程器结果窗口中：“KitProg Bootloader device is detected” （已检
测到 KitProg Bootloader 器件）。
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图 6- 43.
PSoC 编程器结果窗口
4. 切换到 PSoC 编程器窗口中的 Utilities 选项卡，并点击 Upgrade Firmware 按钮。点击 Upgrade
Firmware 按钮前，用户需要在 PC 端拔掉其他所有 PSoC 编程器（如 MiniProg3、DVKProg 等）。
图 6- 44.
更新固件
5. 编程完成后，用户将看到以下信息 “Firmware Update Finished at <time>”（固件更新在 < 时间 >
内完成）。
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图 6- 45.
固件更新结束
6. 用户已成功恢复 PSoC 5LP 的出厂设置。它可作为 Pioneer 套件上 PSoC 4 器件的编程器 / 调试器使
用。
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6.4.1.2
使用 USB 主机工具恢复 PSoC 5LP 的出厂设置
1. 在 Cypress > PSoC Creator 启动菜单中启动 Bootloader 主机工具。
2. 启动 Bootloader 主机工具后，通过使用 File > Open 菜单，可以加载同套件软件一起安装的 “Kit
Prog.cyacd” 文件。该文件的默认位置为：
<Install Path>\CY8CKIT-042 PSoC 4 Pioneer Kit\<version>\Firmware\Programmer\KitProg\KitProg.cyacd
图 6- 46.
加载 KitProg.cyacd 文件
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3. 在服务模式中配置Pioneer套件 — 当按住复位按键(“SW1 Reset”)时，使用所包含的USB电缆
（USB A 到 USB 微型 B）将 PSoC 4 Pioneer 套件插入电脑。这样的操作会使 PSoC 5LP 进入服
务模式，其状态由闪烁状态的绿色 LED 显示。
4. 在Bootloader Host工具中，设置USB器件的滤波器，其中VID设为04B4；PID设为F13B。“USB
Human Interface Device” 端口出现在端口列表中。通过点击选择该端口。
图 6- 47.
选择 “USB Human Interface Device”
5. 用户通过将出厂设置引导加载到 Pioneer 套件的 PSoC 5LP 上，目前已经为恢复出厂设置做好了准
备。要想实现该操作，请按下 Program 按钮 （或从菜单项中依次选择 Actions > Program）。
6. 编程完成后，用户即可看到以下信息 “Programming Finished Successfully” （成功完成编程）。
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图 6- 48.
成功完成编程
7. 用户已成功地恢复 PSoC 5LP 的出厂设置。它可作为 Pioneer 套件上 PSoC 4 器件的编程器 / 调试器
使用。
6.4.2
使用标准的应用程序编程 PSoC 5LP
若使用标准的应用程序编程 PSoC 5LP，那么，用户可以通过以下方法恢复为出厂设置。
1. 从 Cypress > PSoC Programmer 启动菜单中启动 PSoC Programmer 3.xx。
2. 一旦启动了 PSoC 编程器，请通过依次选择 File > Open 菜单加载随该套件附带的十六进制
“KitProg.hex” 出厂设置文件。该文件默认的位置为：
<Install Path>\CY8CKIT-042 PSoC 4 Pioneer Kit\<version>\Firmware\Programmer\KitProg
3. 将 MiniProg3 （CY8CKIT-002 未包含在内，单独销售）连接到计算机。将 MiniProg3 的 10 引脚连
接器电缆插入到插头 [J7] 内。注意，插头未被连接。更多的详细信息，请参见第 102 页上的 A.6
物料清单 （BOM）中的内容。 .
4. 请确保 MiniProg3 是 PSoC 编程器中选定的端口，并且已选中 10 引脚连接器选项，如下图所示。若
USB 不为电路板供电，用户需要将编程模式设置为 “Power Cycle”。
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图 6- 49.
选择 MiniProg3
5. 就绪状态下，请按下 Program 按钮（或在菜单项中依次选择 File > Program），以编程 PSoC 5LP
器件。
6. 编程完成后，用户将看到以下信息：“Program Finished at <time>” （< 时间 > 完成编程）。
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图 6- 50.
编程完成
7. 用户已成功地恢复 PSoC 5LP 的出厂设置。它可作为 Pioneer 套件上 PSoC 4 器件的编程器 / 调试器
使用。
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A.
A.1
附录
CY8CKIT-042 原理图
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P5LP_SWDIO
P5LP_SWDCLK
P5LP1_2
P5LP_SWO
P5LP_TDI
EPAD
P2_5
VDDIO2
P2_4
P2_3
P2_2
P2_1
P2_0
P15_5
P15_4
VDDD
VSSD
VCCD
P0_7
P0_6
P0_5
P0_4
VDDIO0
0603
R7 ZERO
P5LP0_3
P5LP0_2
P5LP0_1
P5LP0_0
P5LP12_3
P5LP12_2
VSSD
0603
P5LP_VDD
C17
0.1 uF
P5LP12_1
P5LP12_0
P5LP3_7
P5LP3_6
C19
1.0 uF
0603
P5LP0_4 to P5LP0_7,
P5LP3_2, P5LP3_3 are
reserved for HW REV ID
P5LP_VDD
R40
3K
R38
3K
0402
C22
0.1 uF
R41
4.7K
0603
R37
1.5K
0402
C21
0.1 uF
P5LP_VDD
DP
DM
R39
1.5K
0603
P5LP_VDD
P5LP3_4
P5LP3_5
P5LP3_0
P5LP3_1
P5LP1_7
P5LP12_6
P5LP12_7
22E R26 DP_P
DM_P
22E R27
VSSD
P5LP_VCCD
VTARG
0603
VBUS
0603
P5LP1_6
0402
C20
0.1 uF
C18
1.0 uF
0402
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
P5LP_VDD
51
50
49
48
47
46
45
44
43
42
41
40
39
38
37
36
35
C23
1.0 uF
0603
0402
C24
0.1 uF
P5LP_XRES
P5LP12_3
0603
R22
2.2K
R23
2.2K
0603
P5LP12_2
PSoC 5LP Programmer / Debugger
R24
P5LP12_1
P3_1
0603
ZERO
R25
P5LP12_0
P3_0
0603
ZERO
I2C Connection b/w PSoC 5LP and PSoC 4
P5LP_VDD
VTARG
R32 ZERO
SWDIO
P5LP2_0
P5LP2_1
P5LP2_2
P5LP2_3
P5LP2_4
J7
R33 ZERO
C27
SWDCLK
0402
R34 ZERO
/XRES
0.1 uF
TVS2
5V 350W
2
4
6
8
10
0603
0.1 uF
1
3
5
7
9
0603
0402
TVS1
5V 350W
J6
C25
1
3
5
7
9
2
4
6
8
10
P5LP_SWDIO
P5LP_SWDCLK
P5LP_SWO
P5LP_TDI
P5LP_XRES
0603
50MIL KEYED SMD
50MIL KEYED SMD
NO LOAD
PSoC 5LP Program/Debug Header
PSoC 4 / External PSoC Program/Debug Header
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Shield
P1_5
P1_4
R44 ZERO
P0_1
P1_3
NO LOAD
P4_2
P1_2
P1_1
Shunt
Resistor
SW1
R17 R18 R19 R20 R21
0603
C1
2200 pF
R45 ZERO
1
/XRES
1
560 ohm
2
560 ohm
3
560 ohm
4
560 ohm
5
560 ohm
R1
NO LOAD
2
EVQ-PE105K
RESET
0603
CSS1
SW2
CAPSENSE TUNING CIRCUITRY
Default Loaded For CSD
Shield Setting
1
P0_7
2
EVQ-PE105K
CapSense Slider 5 Seg
USER BUTTON
D9
R28
2.2K
1
P1_6
R29
1.5K
R30
1.5K
4
P4_VDD
R
P0_2
G
2
3
P0_3
B
RGB LED
P5LP_VDD
R31
D10
2
1
P5LP3_1
0805
0805
330 ohm
Status LED Green
User Interface
P4_VDD
J5
P3_5
P3_0
P3_1
P0_6
P5LP_VDD
J8
P5LP1_2
P5LP0_1
P5LP3_5
P5LP3_7
P5LP12_7
P5LP3_0
2
4
6
8
10
12
P4_VDD
1
3
5
7
9
11
P5LP0_0
P5LP3_4
P5LP3_6
P5LP12_6
J12
P3_1
P0_6
/XRES
1
2
3
4
5
6
2
4
6
P3_0
3x2 RECPT
NO LOAD
6X1 CONN FEMALE
NO LOAD
J12 Arduino ICSP
compatible header for
SPI Interface
6x2 RECPT
PSoC 5LP GPIO Extension Header
1
3
5
J5 Digilent PMOD Cards
Compatible Headers
P4_VDD
TP4
BLACK
TP5
BLACK
TP6
BLACK
R8
2.2K
I2C Pull up
R9
2.2K Resistors
J3
VIN
VBUS
TP3
BLACK
TVS4
18V 350W BI
NO LOAD
0603
NO LOAD
0603
NO LOAD
P4_0
P4_1
J1
1
2
3
4
5
6
7
8
D4
SOD123
V3.3_EXT
/XRES
IOREF
P4_VDD
10
9
8
7
6
5
4
3
2
1
P1_7
P0_6
P3_1
P3_0
P3_4
P3_6
P2_6
8x1 RECP
10X1 RECP
J2
P2_0
P2_1
P2_2
P2_3
P2_4
P2_5
P0_0
P0_1
P1_0
1
3
5
7
9
11
13
15
17
2
4
6
8
10
12
14
16
18
P0_2
P0_3
P4_VDD
J4
P0_4
P0_5
P0_7
P3_7
P0_0
P3_5
P1_0
P2_7
P1_5
P1_4
P1_3
P1_2
P1_1
9x2 RECP
1
2
3
4
5
6
7
8
8x1 RECP
(J1-J4) Arduino Compatible Headers
NO LOAD
R46 ZERO
Vz=2V(BZT52C2V0-7-F)
TVS3
5V 350W
Q1
PMOS( DMP3098L-7)
NO LOAD
0603
V3.3_EXT
PMOS( DMP3098L-7)
V3.3
Q2
R43
442 ohm
Q3
PMOS( DMP3098L-7)
D5
R42
1K ohm
Protection Circuit
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引脚分配表
A.2
本部分提供了插座的引脚映射图以及它的使用情况。
A.2.1
Arduino 兼容的插座 （J1、 J2、 J3、 J4 以及 J12）
J1
引脚
套件信号
说明
J1_01
VIN
电路板的输入电压
J1_02
GND
GND
J1_03
GND
GND
J1_04
5V
5V 电压
J1_05
3.3V
3.3V 电压
J1_06
RESET
/XRES
J1_07
IOREF
IO 电压参考
J1_08
NC
电压参考
J2
引脚
PSoC 4 信号
PSoC 4 说明
引脚
PSoC 4 信号
PSoC 4 说明
J2_01
P2[0]
A0 （SARADC 输入）
J2_02
P0[2]
比较器 2+
J2_03
P2[1]
A1 （SARADC 输入）
J2_04
P0[3]
比较器 2-
J2_05
P2[2]
A2 （SARADC 输入）
J2_06
VDD
VDD
J2_07
P2[3]
A3 （SARADC 输入）
J2_08
P1[5]
运算放大器 2+
J2_09
P2[4]
A4 （SARADC 输入）
J2_10
P1[4]
运算放大器 2-
J2_11
P2[5]
A5 （SARADC 输入）
J2_12
P1[3]
运算放大器 2out
J2_13
P0[0]
比较器 1+
J2_14
GND
GND
J2_15
P0[1]
比较器 1-
J2_16
P1[2]
运算放大器 1out
J2_17
P1[0]
运算放大器 1+
J2_18
P1[1]
运算放大器 1-
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J3
引脚
PSoC 4 信号
PSoC 4 说明
J3_01
P2[6]
D8
J3_02
P3[6]
D9(PWM)
J3_03
P3[4]
D10(PWM/SS)
J3_04
P3[0]
D11(PWM/MOSI)
J3_05
P3[1]
D12(MISO)
J3_06
P0[6]
D13(SCK)
J3_07
GND
GND
J3_08
P1[7]
AREF
J3_09
P4[1]
SDA
J3_10
P4[0]
SCL
J4
引脚
PSoC 4 信号
PSoC 4 说明
J4_01
P0[4]
D0(RX)
J4_02
P0[5]
D1(TX)
J4_03
P0[7]
D2
J4_04
P3[7]
D3(PWM)
J4_05
P0[0]
D4
J4_06
P3[5]
D5(PWM)
J4_07
P1[0]
D6(PWM)
J4_08
P2[7]
D7
J12
引脚
PSoC 4 说明
套件信号
J12_01
P3[1]
MISO
J12_02
PSoC 4_VDD
VDD
J12_03
P0[6]
SCK
J12_04
P3[0]
MOSI
J12_05
/XRES
PSoC 4 RESET
J12_06
GND
GND
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A.2.2
支持 Digilent Pmod 卡的插座 （J5）
J5
引脚
PSoC 4 说明（默认 Pmod 信号）
套件信号
J5_01
P3[5]
SPI_SS （与 J4_06 复用）
J5_02
P3[0]
SPI_MOSI
J5_03
P3[1]
SPI_MISO
J5_04
P0[6]
SPI_SCK
J5_05
GND
GND
J5_06
VDD
VCC
A.2.3
PSoC 5LP GPIO 插座 （J8）
JJ8 是 2x6 的插座， 用于连接 PSoC 5LP 的各个引脚，以便支持自定义 PSoC5LP 项目的 GPIO 控制。
J8
PSoC 5 LP 信
号
引脚
PSoC 5LP 说明
PSoC 5 LP 信
号
引脚
PSoC 5LP 说明
J8_01
PSoC 5 LP_VDD
VDD
J8_02
P1[2]
数字 I/O
J8_03
P0[0]
Delta Sigma ADC + 输
入
J8_04
P0[1]
Delta Sigma ADC – 输
入
J8_05
P3[4]
SAR – 输入
J8_06
P3[5]
SAR + 输入
J8_07
P3[6]
缓冲 VDAC
J8_08
P3[7]
缓冲 VDAC
J8_09
P12[6]
UART RX
J8_10
P12[7]
UART TX
J8_11
GND
GND
J8_12
P3[0]
IDAC 输出
A.3
编程与调试插座
A.3.1
PSoC 4 直接编程 / 调试插座 （J6）
J6
引脚
J6_01
PSoC 5 LP
信号
PSoC 4 信号
VDD
VDD
说明
VCC
引脚
J6_02
PSoC 5 LP
信号
PSoC 4 信号
P2[0]
P3[2]
说明
TMS/SWDIO
J6_03
GND
GND
GND
J6_04
P2[1]
P3[3]
TCLK/SWCLK
J6_05
GND
GND
GND
J6_06
P2[2]
NC
TDO/SWO
J6_07
NC
GND
GND
J6_08
P2[3]
NC
TDI
J6_09
GND
GND
GND
J6_10
P2[4]
XRES
RESET
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A.3.2
PSoC 5LP 直接编程 / 调试插座 （J7）
J7
引脚
PSoC 5 LP 信号
引脚
说明
说明
PSoC 5 LP信号
J7_01
VDD
VCC
J7_02
P1[0]
TMS/SWDIO
J7_03
GND
GND
J7_04
P1[1]
TCLK/SWCLK
J7_05
GND
GND
J7_06
P1[3]
TDO/SWO
J7_07
GND
GND
J7_08
P1[4]
TDI
J7_09
GND
GND
J7_10
XRES
RESET
A.4
零欧姆电阻器与空载的使用情况
电阻器
单位
用途
电源
R2
焊接零欧姆电阻，以访问 VBUS （USB）的电压。
PSoC 5LP 和 PSoC 4 和 PSoC 4 间
的 I2C 连接
R24 和 R25
拆焊电阻器，以便可以同使用 PSoC 5LP 的外部 PSoC 进行通
信。移除这些电阻器将阻止 PSoC 5LP 设备对 PSoC 4 的编程。
PSoC 4/ 外部 PSoC编程 / 调试头部
R32、 R33 和
R34
拆焊电阻器，以断开 SWD 线盒 PSoC 4 的连接。使用 J6 连接至
某个外部 PSoC 并且编程它。
保护电路
R46
焊接零欧姆电阻，以直通整个保护电路。
CapSense 调试电路
R1
配置为 CSD 的 RBleed 模式时会使用到该电阻器。想要使用该功
能，用户想要填入一个 Rbleed 电阻器。请参见 CapSense 组件
的数据手册。
CapSense 屏蔽设置
R44、 R45
拆焊连接屏蔽至地面的 R45，焊接连接 Vref 至 P0_1 的 R44
（R44 具有零欧姆电阻）。
PSoC 4
R4、 R6
拆焊 R44，以删除 VTARG 的电源；焊接零欧姆电阻 R6，以
VDD 而不是 J13 供电给 P4 _VDD。
PSoC 5 LP 编程器 / 调试器
R11、 R12、
R14、 R15 以
及 R16
备将来使用。
R5
拆焊零欧姆电阻器，以调整 VDD 供电符合 PSoC 5LP。
R7
备将来使用。
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固件中的错误 / 状态 LED 中的状态指示
A.5
用户指示
LED 以高速度闪炼
1
（ON 时长为 0.25 秒， OFF 时长为
0.25 秒）
LED 以低速度闪炼
2
（ON 时长为 1.5 秒， OFF 时长为 1.5
秒）
3
LED 发光稳步
脚本
用户需要采取的行动
Bootloadable 被损
坏
使用 PSoC Creator 附带的 Bootloader 主机 GUI 通过
PSoC编程器附带的USB接口来引导加载*.cyacd文件。
这些文件位于 PSoC 编程器的安装根目录中。
通过按住 PSoC 4
的复位开关来进入
Bootloader
编程器应用成功运
行
a) 如果由于意外，用户进入了该模式，那么拔下电源，
再重新插上。 LED 给用户发出一个指示。
b) 如果用户主定进入该模式，使用 PSoC creator 附带
的 Bootloader 主机工具引导加载新的 *.cyacd 文件。
USB 枚举成功，编程器启动并运行。现在，可以使用
板上 PSoC 5LP 编程器随时编程 PSoC 4 器件。
注意：自定义项目运行于 PSoC 5LP 时，不采用 LED 状态。
物料清单 （BOM）
A.6
序号 数量
参考选项
值
说明
制造商
制造商器件编号
PCB,3.32"x2.1" CAF resistant
High Tg ENIG finish, 4 layer,
1
Cypress
Color = RED, Silk = WHITE.
2
12
C2、 C7、 C12、
C14、 C15、 C17、
0.1 uFd
C20、 C21、 C22、
C24、 C25、 C27
CAP .1UF 16V CERAMIC Y5V
0402
4
11
C3、 C5、 C8、
C10、 C11、 C13、
1.0 uFd
C18、 C19、 C23、
C26、 C28
CAP CERAMIC 1.0UF 25V X5R
Taiyo Yuden
0603 10%
5
1
C4
10 uF 25V
CAP TANT 10UF 25V 10%
1210
AVX Corporation TPSB106K025R1800
6
1
C6
22 uF 16V
CAP TANT 22UF 16V 10%
1210
AVX Corporation TPSB226K016R0600
7
1
C9
10000 pFd
CAP CER 10000PF 50V 5%
NP0 0805
Murata
8
1
C16
0.01 uFd
CAP 10000PF 16V CERAMIC
0402 SMD
Panasonic - ECG ECJ-0EB1C103K
9
6
D1、 D2、 D4、
D11、 D12、 D13
MBR05
DIODE SCHOTTKY 0.5A 20V
SOD-123
Fairchild Semiconductor
102
0805
Murata
GRM2165C1H222JA01D
C1
3
2200 pFd
CAP CER 2200PF 50V 5% NP0
1
Panasonic - ECG ECJ-0EF1C104Z
TMK107BJ105KA-T
GRM2195C1H103JA01D
MBR0520L
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序号 数量
参考选项
值
说明
制造商
制造商器件编号
10
1
D3
Power LED LED AMBER 591NM DIFF
Amber
LENS 2012
11
1
D5
2V Zener
DIODE ZENER 2V 500MW
SOD123
Diodes Inc
BZT52C2V0-7-F
12
3
D6、D7、 D8
ESD diode
SUPPRESSOR ESD 5VDC
0603 SMD
Bourns Inc.
CG0603MLC-05LE
13
1
D9
RGB LED
LED RED/GREEN/BLUE
PLCC4 SMD
Cree, Inc.
CLV1A-FKBCJ1M1F1BB7R4S3
14
1
D10
Status LED LED GREEN CLEAR 0805
Green
SMD
Chicago Miniature
CMD17-21VGC/TR8
15
1
F1
FUSE
PTC Resettable Fuses 15Volts
100Amps
Bourns
MF-MSMF050-2
16
2
J1、 J4
8x1 RECP
CONN HEADER FEMALE
8POS .1" GOLD
Sullins Connector Solutions
PPPC081LFBN-RC
17
1
J2
9x2 RECP
CONN HEADER FMAL 18PS.1" Sullins ConnecDL GOLD
tor Solutions
PPPC092LFBN-RC
18
1
J3
10x1 RECP
CONN HEADER FMALE
10POS .1" GOLD
PPPC101LFBN-RC
19
1
J6
50MIL
KEYED
SMD
CONN HEADER 10 PIN 50MIL
Samtec
KEYED SMD
FTSH-105-01-L-DV-K
20
1
J8
6x2 RECP
CONN HEADER FMAL 12PS.1" Sullins ConnecDL GOLD
tor Solutions
PPPC062LFBN-RC
21
1
J9
3p_jumper
CONN HEADER VERT SGL
3POS GOLD
3M
961103-6404-AR
22
1
J10
USB Mini B
CONN USB MINI AB SMT
RIGHT ANGLE
TE Connectivity
1734035-2
23
1
J13
2p_jumper
CONN HEADER VERT SGL
2POS GOLD
3M
961102-6404-AR
24
3
Q1、 Q2、 Q3
PMOS
MOSFET P-CH 30V 3.8A
SOT23-3
Diodes Inc
DMP3098L-7
25
1
R3
560 ohm
RES 560 OHM 1/8W 5% 0805
SMD
Panasonic - ECG ERJ-6GEYJ561V
26
12
R4、 R11、 R12、
R14、 R15、 R16、
ZERO
R24、 R25、 R32、
R33、 R34、 R45
RES 0.0 OHM 1/10W 0603
SMD
Panasonic-ECG
ERJ-3GEY0R00V
27
1
R5
ZERO
RES 0.0 OHM 1/8W 0805 SMD Panasonic-ECG
ERJ-6GEY0R00V
28
4
R8、 R9、 R22、
R23
2.2K
RES 2.2K OHM 1/10W 5%
0603 SMD
Panasonic - ECG ERJ-3GEYJ222V
29
2
R10、 R41
4.7K
RES 4.7K OHM 1/10W 5%
0603 SMD
Panasonic-ECG
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Sharp MicroelecLT1ZV40A
tronics
Sullins Connector Solutions
ERJ-3GEYJ472V
103
序号 数量
参考选项
值
100K
说明
RES 100K OHM 1/10W 5%
0402 SMD
制造商
制造商器件编号
30
1
R13
Panasonic - ECG ERJ-2GEJ104X
31
5
R17、 R18、 R19、
560 ohm
R20、 R21
32
2
R26、R27
22E
RES 22 OHM 1/10W 1% 0603
SMD
33
1
R28
2.2K
RES 2.2K OHM 1/8W 5% 0805
Panasonic - ECG ERJ-6GEYJ222V
SMD
34
2
R29、 R30
1.5K
RES 1.5K OHM 1/8W 5% 0805
Panasonic - ECG ERJ-6GEYJ152V
SMD
35
1
R31
330 ohm
RES 330 OHM 1/8W 5% 0805
SMD
36
1
R35
232 ohm
RES 232 OHM 1/10W 1% 0603
Panasonic - ECG ERJ-3EKF2320V
SMD
37
1
R36
120 ohm
RES 120 OHM 1/10W 1% 0603
Panasonic - ECG ERJ-3EKF1200V
SMD
38
2
R37、 R39
1.5K
RES 1.5K OHM 1/10W 5%
0603 SMD
Panasonic - ECG ERJ-3GEYJ152V
39
2
R38、 R40
3K
RES 3.0K OHM 1/10W 5%
0603 SMD
Panasonic - ECG ERJ-3GEYJ302V
40
1
R42
1K
RES 1K OHM 1/8W 5% 0805
SMD
Panasonic - ECG ERJ-6GEYJ102V
41
1
R43
442 ohm
RES 442 OHM 1/10W 1% 0603
Panasonic - ECG ERJ-3EKF4420V
SMD
42
2
SW1、 SW2
SW PUSH- SWITCH TACTILE SPST-NO
BUTTON
0.05A 12V
43
1
TP5
BLACK
TEST POINT PC MINI .040"D
Black
Keystone Electronics
5001
44
2
TVS1、 TVS2
5V 350W
TVS UNIDIR 350W 5V SOD323
Dioded Inc.
SD05-7
45
1
TVS4
18V 350W
TVS DIODE 18V 1CH BI SMD
Bourns Inc.
CDSOD323-T18C
46
1
U1
NCP1117D
NCP1117DTARKG
TARKG
ON SemiconducNCP1117DTARKG
tor
47
1
U2
PSoC 4
(CY8C4245 44TQFP PSoC4A target chip
AXI-483)
Cypress Semiconductor
48
1
U3
PSoC 5LP 68QFN PSoC 5LP chip for USB
Cypress Semi(CY8C5868 debug channel and USB-Serial
conductor
LTI-LP039 ) interface
RES 560 OHM 1/10W 5% 0603
Panasonic-ECG
SMD
ERJ-3GEYJ561V
Panasonic - ECG ERJ-3EKF22R0V
Panasonic - ECG ERJ-6GEYJ331V
Panasonic - ECG EVQ-PE105K
CY8C4245AXI-483
CY8C5868LTI-LP039
No Load Components
49
104
1
C29
1.0 uFd
CAP CERAMIC 1.0UF 25V X5R
Taiyo Yuden
0603 10%
TMK107BJ105KA-T
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序号 数量
参考选项
值
说明
制造商
制造商器件编号
50
1
J5
6X1 RECP CONN FEMALE 6POS .100" R/ Sullins ConnecRA
A GOLD
tor Solutions
PPPC061LGBN-RC
51
1
J7
50MIL
KEYED
SMD
CONN HEADER 10 PIN 50MIL
Samtec
KEYED SMD
FTSH-105-01-L-DV-K
52
1
J11
2 PIN HDR
CONN HEADER FEMALE
2POS .1" GOLD
Sullins Connector Solutions
PPPC021LFBN-RC
53
1
J12
3x2 RECPT
CONN HEADER FMAL 6PS .1" Sullins ConnecDL GOLD
tor Solutions
PPPC032LFBN-RC
54
5
R1、 R2、 R7、
R44、 R46
ZERO
RES 0.0 OHM 1/10W 0603
SMD
Panasonic-ECG
ERJ-3GEY0R00V
55
1
R6
ZERO
RES 0.0 OHM 1/8W 0805 SMD Panasonic-ECG
ERJ-6GEY0R00V
56
2
TP1、 TP2
RED
TEST POINT PC MINI .040"D
RED
Keystone Electronics
5000
57
3
TP3、 TP4、 TP6
BLACK
TEST POINT PC MINI .040"D
Black
Keystone Electronics
5001
58
1
TVS3
5V 350W
TVS UNIDIR 350W 5V SOD323
Dioded Inc.
SD05-7
3M
SJ61A6
J9
Install
Rectangular Connectors MINI
jumper
JUMPER GF 6.0MM CLOSE
across pins
TYPE BLACK
1 and 2
Kobiconn
151-8010-E
J13
Install
Rectangular Connectors MINI
jumper
JUMPER GF 6.0MM CLOSE
across pins
TYPE BLACK
1 and 2
Kobiconn
151-8010-E
Install on Bottom of PCB As per the Silk Screen in the Corners
59
4
N/A
N/A
BUMPON CYLINDRICAL.312X.215 BLACK
Special Jumper Installation Instructions
60
61
1
1
Label
62
1
N/A
N/A
LBL, Kit Product Identification
Label, Vendor Code, Datecode, Cypress SemiSerial Number CY8CKIT-042
conductor
Rev** (YYWWVVXXXXX)
63
1
N/A
N/A
LBL, PCBA Anti-Static Warning, 10mm X 10mm
Cypress Semiconductor
64
1
N/A
N/A
Assembly Adhesive Label,
Manufacturing ID
Cypress Semiconductor
65
1
N/A
N/A
Kit QR code
Cypress Semiconductor
CY8CKIT-042 PSoC 4 Pioneer 套件指南，文档 # 001-90179 Rev. **
105
A.7
合规性信息
CY8CKIT-042 已经经过测试和验证，符合下面电磁兼容性 （EMC）的规定：
106
■
EN 55022:2010 A 类 — 辐射
■
EN 55024:2010 A 类 — 抗性
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